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SEZNAM POUŽITÝCH ZKRATEK 
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HEC-HMS Hydrologic Engineering Centers - Hydrologic Modeling System 

HEC-RAS Hydrologic Engineering Centers - River Analysis System 

HZS Hasičský záchranný sbor 

JPO Jednotka požární ochrany 
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OS Operační systém 

Q100 Stoletý (maximální) průtok 

Q355d. Průměrný 355-denní průtok 

Qmin Trvalý minimální průtok 

QN Čára opakování kulminačních průtoků 

QZPV1 Průtok zvláštní povodňové vlny s označením 1-3 

s.p. Státní podnik 

TIN Triangulated irregular network 

VD Vodní dílo 

VUT Vysoké učení technické 

ZABAGED® Základní báze geografických dat České republiky 

ZPV1-3 Zvláštní povodňová vlna s označením 1-3 
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ÚVOD 

Lidé si celá staletí uvědomovali možnosti hospodaření s vodou, která patří mezi 

nejdůležitější látky na zemi. Z počátku se jednalo pouze o odvodňování bažin a mokřadů 

a zřizování rybníků, ale s pozdějším vývojem technických znalostí a rostoucími nároky 

na užívání vody (zásobování pitnou vodou, regulace vodních toků, ochrana území před 

povodněmi apod.) začaly vznikat složitější stavby na daných tocích tzv. vodní díla. Mezi 

nejznámější vodní díla se řadí zejména přehrady, hráze a vodní nádrže.  

Se stavbou a provozem těchto vodních děl je spojeno riziko částečného, či úplného 

porušení hrazení, které může zapříčinit destrukci daného díla a následně způsobit zvláštní 

povodeň. Jednou z nejznámějších katastrof přehradního stavitelství, která se udála roku 

1916, je protržení nádrže Bílá Desná v Jizerských horách. 

Z hlediska vzniku a průběhu zvláštních povodní způsobených destrukcí vodního díla 

jsou nejvýznamnější díla zařazená do I. a II. kategorie, která by po protržení hráze měla 

katastrofální následky. U těchto děl je v dnešní době velmi malá pravděpodobnost této 

situace, jelikož jsou stavěna ze železobetonových konstrukcí a jsou pod stálým technicko-

bezpečnostním dohledem. Snad jediný způsob, při kterém by mohlo dojít k destrukci 

vodního díla I. a II. kategorie, je technická porucha závažného charakteru, nebo 

teroristický útok. Oproti tomu u vodních děl spadajících do III. a IV. kategorie (hráze 

jsou zemní sypané, naplavované, balvanovité) je protržení pravděpodobnější díky 

špatnému technickému stavu mnoha těchto děl, nebo je způsobeno následkem přirozené 

povodně 50-100 letého charakteru.  

V dnešní době tyto katastrofy nelze vyloučit, ale se současnými programy sloužícími 

k modelování těchto extrémních hydrologických jevů lze určit velikost záplavové vlny 

pro jednotlivé druhy zvláštních povodní a stanovit tak rozsah území, které bude touto 

zvláštní povodní zasaženo. V České republice jsou dle zákona č. 254/2001 na vodních 

dílech I. až III. řádu provozovatelé těchto vodních děl povinni vést a poskytovat 

příslušným povodňovým orgánům, orgánům krizového řízení a orgánům integrovaného 

záchranného systému údaje o parametrech možné zvláštní povodně (zejména 

charakteristiky povodňových vln a rozsah ohroženého území). Na vodních dílech IV. 

řádu tyto údaje vedeny být nemusí. 

Výsledky hydrologických modelů pak využívají složky integrovaného záchranného 

systému pro plánování opatření na ochranu obyvatelstva při hrozící či nastalé krizové 

situaci v podobě povodňové vlny způsobené destrukcí vodního díla.  

Vodní nádrž Moravská Třebová patří mezi vodní díla IV. řádu a hned pod hrází se na 

vodním toku Třebůvka nachází stejnojmenné město plynule přecházející v obec 

Linhartice. Při destrukci vodního díla může následná povodňová vlna ohrožovat rodinné 

domy nebo průmyslové stavby nacházející se v blízkosti vodního toku, to bylo také 

hlavním důvodem, proč byla vodní nádrž vybrána pro namodelování záplavové vlny 

zvláštní povodně v této bakalářské práci. 
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1     CÍLE PRÁCE 

Cílem bakalářské práce je namodelování povodňové vlny při destrukci vybrané vodní 

nádrže a její zobrazení v mapě s  následným hodnocením zaplaveného území, které bude 

obsahovat navazující informace z oblasti ochrany obyvatelstva. Vybranou vodní nádrží je 

vodní dílo Moravská Třebová. Následné hodnocení je vztaženo na město Moravská 

Třebová a obec Linhartice. Oproti zadání bakalářské práce nebyl pro modelování 

záplavové vlny použit srážko-odtokový model HEC-HMS, ale mnohem vhodnější 

hydrodynamický model HEC-RAS. 

K dílčím cílům patří získání a příprava dat, popř. informací potřebných pro naplnění 

hydrodynamického modelu HEC-RAS s popisem průběhu tohoto modelování, vytyčení 

záplavové zóny zvláštní povodně způsobené destrukcí vodní nádrže a následné stanovení 

zaplavené oblasti.    

V teoretické části budou obsaženy kapitoly týkající se stručné charakteristiky 

zájmového území a daného vodního díla, ochrany obyvatelstva, extrémních 

hydrologických jevů, hydrologických modelů a modelování proudění v korytě. Praktická 

část bude zaměřena na přípravu dat a následné modelování v prostředí softwaru HEC-

RAS. Výsledky této práce budou prezentovány jak v podobě mapových výstupů, tak 

slovním hodnocením.  

Bakalářská práce bude odevzdána jak v analogové, tak v digitální podobě. O této 

práci bude vytvořena webová stránka, která bude umístěna na katedrální server.  
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2 VYMEZENÍ ZÁJMOVÉHO ÚZEMÍ 

Zájmové území se sledovaným vodním dílem (dále jen VD) Moravská Třebová se 

nalézá v Pardubickém kraji u stejnojmenné obce. Územím protéká vodní tok Třebůvka a 

je prostorově vymezeno povodími IV. stupně: 4-10-02-066, 4-10-02-067, 4-10-02-068, 4-

10-02-069, 4-10-02-070, 4-10-02-071, 4-10-02-072, 4-10-02-073, 4-10-02-074, 4-10-02-

075, 4-10-02-076, 4-10-02-077, 4-10-02-078, 4-10-02-079 (viz Obr. 1). Tato jednotlivá 

povodí obsahují zčásti nebo celé obce: Útěchov, Hrušov, Dětřichov u Moravské Třebové, 

Gruna, Dětřichov, Dlouhá Loučka, Jevíčko, Kamenná, Horka, Koclířov, Křenov, 

Kunčina, Linhartice, Malíkov, Městečko Trnávka, Mladějov na Moravě, Moravská 

Třebová, Pohledy, Rozstání, Rychnov na Moravě a Staré Město. Rozloha celého 

vymezeného území je 131,4 km².  

 

 

 

 

 

 

Obr. 1: Lokalizace zájmového území s vymezením hranic povodí IV. stupně (Data: DIBAVOD, 

ZABAGED) 

http://cs.wikipedia.org/wiki/Kilometr_%C4%8Dtvere%C4%8Dn%C3%AD
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2.1 Hydrologická charakteristika 

Zájmové území patří k povodí řeky Moravy (Dunaje) a k úmoří Černého moře. 

Nejvýznamnějším vodním tokem, který prochází tímto územím a na němž leží i VD 

Moravská Třebová, je vodní tok III. řádu řeka Třebůvka (pravostranný přítok řeky 

Moravy). Pramen se nachází nedaleko obce Křenov ve výšce 462 m n. m., celková délka 

vodního toku je 48,3 km (ve vymezeném území 16,25 km), plocha povodí je 584,6 km² 

(ve vymezeném území 131,36 km²). Do Třebůvky se vlévají v tomto území vodní toky 

IV. řádu. Hydrologická charakteristika vodních toků a jejich částí je uvedena v Tab. 1-3.      

 

Tab. 1: Hydrologická charakteristika vodních toků v zájmovém území (převzato: Hydrologické 

poměry Československé socialistické republiky, 1. díl – text, 1965) 

Vodní tok Přítok 
Řád 

toku 

Plocha 

povodí (P)    

[km
2
] 

Délka 

údolí (L)    

[km] 

Charakter 

povodí 

(P/L
2
) 

Lesnatost       

[%] 

Hřebčovský potok levostranný IV. 9,537 5,0 0,38 60 

Stříbrný potok levostranný IV. 9,538 6,0 0,27 40 

Kunčinský potok levostranný IV. 56,408 10,5 0,51 30 

Hraniční potok pravostranný V. 10,538 6,9 0,22 40 

Bílý potok levostranný V. 14,558 7,8 0,24 20 

Udánský potok pravostranný V. 10,458 6,8 0,23 30 

Borušovský potok levostranný IV. 11,148 6,0 0,31 30 

Třebůvka pravostranný III. 584,570 47,0 0,26 40 

 

Tab. 2: Charakteristické hydrologické údaje zájmového území (převzato: Hydrologické poměry, 

3. díl, 1970) 

ČHP Tok Místo 

Velké vody dosažené nebo překročené průměrně jednou 

za 

1 2 5 10 20 50 100 

roků [m
3
/s] 

4-10-02-070 Třebůvka 

nad 

Kunčinským 

potokem 

9 18 30 41 48 55 60 

4-10-02-077 
Kunčinský 

potok 
ústí 10 19 31 42 50 57 62 

4-10-02-078 Třebůvka 

pod 

Kunčinským 

potokem 

14 28 45 60 72 83 90 
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Tab. 3: Charakteristické hydrologické údaje zájmového území (převzato: Hydrologické poměry, 

3. díl, 1970) 

ČHP Tok Místo 

Průměrné roční hodnoty 

Plocha 

povodí 

[km
2
] 

Srážky 

[mm] 

Rozdíl 

srážek a 

odtoku 

[mm] 

Odtok 

[mm] 

Odtokový 

součinitel 

Průtok 

[m
3
/s] 

4-10-02-070 Třebůvka 

nad 

Kunčinským 

potokem 

52,87 663 509 154 0,23 0,26 

4-10-02-077 
Kunčinský 

potok 
ústí 56,41 665 511 154 0,23 0,27 

4-10-02-078 Třebůvka 

pod 

Kunčinským 

potokem 

109,28 664 510 154 0,23 0,53 

Pozn.: Odtokový součinitel je poměr odtokové výšky a průměrné srážky v povodí. 

 

  Na vodním toku Třebůvka se dnes nacházejí dvě vodoměrné stanice. První je 

vodoměrná stanice Loštice, patřící mezi základní hlásné kategorie A, jejímž 

provozovatelem je Český hydrometeorologický úřad (ČHMÚ). Druhou je stanice 

Mezihoří patřící do kategorie B, tzv. doplňkový hlásný profil. Zřizovatelem této stanice je 

krajský úřad a provozovatelem příslušná obec Mezihoří. Obě zmíněné vodoměrné stanice 

se nacházejí v ORP Moravská Třebová, ale ani jedna se nenachází ve 

vymezeném zájmovém území. Data průměrných extrémních průtoků z vodoměrné stanice 

Loštice jsou uvedeny v Tab. 4. 

 

Tab. 4: Průměrný celkový průtok a extrémní průtoky na vodoměrné stanici Loštice (převzato: 

Hydrologické poměry Československé socialistické republiky, 2. díl, 1967) 

Vodoměrná 

stanice 
Období 

Průměrný 

průtok 

[m3/s] 

Extrémní průtok  [m
3
/s] 

Maximální Datum Minimální Datum 

Loštice 1931-1960 2,35 140 1.9.1938 0,15 13.8.1934 
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2.2 VD Moravská Třebová 

Vodní dílo Moravská Třebová (viz Obr. 2) se nachází na 38,3 km vodního toku 

Třebůvka. Tato víceúčelová vodní nádrž byla vybudována v letech 1961-1962 za účelem 

energetického využití a zajištění trvalého minimálního průtoku v Třebůvce 

Qmin=0,035m
3
/s. Hráz je zemní sypaná s návodním jílovým těsněním. Délka hráze 

v koruně je 141 m, šířka 3,5 m a kóta této koruny kamenité hráze je 358,55 m n. m. (vše 

uvedeno ve výškovém sytému Balt p.v.). Maximální výška hráze nad terénem je 5,05 m. 

Kóta dna údolí je 354,20 m n. m., kóta hladiny je 355,42 m n. m., výpusť je zajišťována 

dvěma spodními ocelovými stavidly o průměru 1200 mm s kapacitou 2×8,2 m
3
/s. Objem 

je 0,2209 milionů m
3
 a zatopená plocha je 11 ha. Tato nádrž přísluší k Moravské 

vodohospodářské soustavě a provozovatelem je státní podnik Povodí Moravy. Účelem 

nádrže je především akumulace vody pro zajištění výše uvedeného minimálního průtoku 

a ochrana před povodněmi. Dalšími účely nádrže jsou rybí hospodářství, rekreace a vodní 

sporty. Tato nádrž příznivě ovlivňuje mikroklima, rozšířením vodního ptactva a 

vodomilné vegetace. Výše uvedené charakteristiky jsou převzaty z díla Průběh zvláštní 

povodně v Třebůvce pod VD Moravská Třebová, 2011. Další hydrologické údaje jsou 

zobrazeny v Tab. 5. 

 

Obr. 2: VD Moravská Třebová (Zdroj: Průběh zvláštní povodně v Třebůvce pod VD Moravská 

Třebová, 2011) 
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Tab. 5: Parametry VD Moravská Třebová (převzato ze studie: Průběh zvláštní povodně 

v Třebůvce pod VD Moravská Třebová, 2011) 

Hydrologické údaje 

Číslo hydrologického pořadí:   4-10-02-070 

Plocha povodí:   47,85 km² 

Průměrný dlouhodobý roční průtok:   0,250 m³/s 

Q100:   48,000 m³/s 

Q355d:   0,062 m³/s 

Účinek nádrže 

Neškodný odtok: 10,000 m³/s 

Minimální odtok: 0,035 m³/s 

Stálé nadržení: 0,030 mil. m³ 

Zásobní prostor: 0,110 mil. m³ 

Hladina zásobního prostoru: 356,87 m n. m. 

Prostor retenční neovladatelný: 0,081 mil. m³ 

Hladina retenčního neovladatelného prostoru: 357,92 m n. m. 

Bezpečnostní přeliv 

Typ bezpečnostního přelivu: boční, nehrazený 

Počet polí × délka přelivu: 1 × 46,0 m 

Kóta přelivu: 

356,87 (15 m); 357,37 (31 m) m n. m. 

Kapacita při max. hladině: 45,50 m³/s 
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3 OCHRANA OBYVATELSTVA 

Ochranou obyvatelstva se rozumí taková opatření, jejíž snahou je zabránit, nebo co 

nejvíce minimalizovat působení ničivých účinků na obyvatelstvo. Ze zákona č. 239/2000 

Sb., o integrovaném záchranném systému a o změně některých zákonů se ochranou 

obyvatelstva rozumí plnění několika základních úkolů: 

 varování obyvatelstva, což je hlavně budování a provoz jednotného systému 

varování a vyrozumění (JSVV)  

 evakuace obyvatelstva, hospodářského zvířectva a věcných prostředků 

 ukrytí, čímž se rozumí kolektivní ochrana obyvatelstva ve stálých, nebo 

improvizovaných úkrytech (o ukrytí obyvatel se v případě povodně neuvažuje) 

 nouzové přežití obyvatelstva v nouzovém ubytování, dále zásobování pitnou 

vodou, potravinami a dalšími nezbytnými prostředky nutnými k přežití 

obyvatelstva 

 další opatření k zabezpečení ochrany života, zdraví a majetku  

 

3.1 Varování obyvatelstva 

Podle Výkladového slovníku krizového řízení a obrany státu Ministerstva vnitra 

(2005) je varování: „Souhrn technických a organizačních opatření zabezpečujících 

včasné upozornění obyvatelstva orgány veřejné správy na hrozící nebo nastalou 

mimořádnou událost, vyžadující realizaci opatření na ochranu obyvatelstva a majetku.“  

Pro upozornění na hrozící, nebo probíhající nebezpečí se používá varovný signál, po 

jehož provedení je neprodleně realizováno informování obyvatelstva o povaze nebezpečí 

a o opatřeních k ochraně života, zdraví a majetku. K tomuto upozornění slouží sirény, 

obecní rozhlasy, přenosná zařízení (megafony) nebo vozidla integrovaného záchranného 

systému. 

V Moravské Třebové se nachází jedna elektronická rotační siréna umístěná na 

městském úřadě a městský rozhlas. V okolních obcích se nachází dalších 12 sirén 

zajišťujících varování a informování obyvatelstva o hrozící, či nastalé mimořádné situaci. 

V obci Linhartice se žádná siréna nenachází, zde je k varování užíván pouze obecní 

rozhlas. V Tab. 6-7 jsou zobrazeny podrobnější informace o siréně a rozhlasech v těchto 

dvou obcích.  

 

Tab. 6: Podrobné informace o siréně v Moravské Třebové (zdroj: HZS Pardubického kraje) 

Obec Objekt Ulice, Č. p. Majitel Druh Typ Typ přijímače 

Moravská 

Třebová 

městský 

úřad 
T.G. Masaryka 29 HZS 

elektronická 

rotační 
DSS 977 DSE300 
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Tab. 7: Podrobné informace o rozhlasech v Moravské Třebové a Linharticích (zdroj: HZS 

Pardubického kraje) 

 

3.2 Evakuace obyvatelstva  

Evakuace je dle Výkladového slovníku krizového řízení a obrany státu Ministerstva 

vnitra (2005): „Souhrn organizačních a technických opatření zabezpečujících přemístění 

osob, zvířat a věcných prostředků v daném pořadí priority z míst ohrožených 

mimořádnou událostí do míst, ve kterých je zajištěno pro osoby náhradní ubytování a 

stravování, pro zvířata ustájení a pro věcné prostředky uskladnění.“ Evakuace probíhá 

do vytipovaných evakuačních center. V Moravské Třebové je evakuačním střediskem 

areál budov Střední technické školy Ministerstva obrany (viz Tab. 8).  

 

Tab. 8: Evakuační střediska pro Moravskou Třebovou a Linhartice (zdroj: HZS Pardubického 

kraje) 

 

Transport raněných by probíhal do jediného zdravotnického centra v ORP Moravská 

Třebová nacházejícího se asi 1 km západně od centra Moravské Třebové, o kterém jsou 

bližší informace vypsány v Tab. 9.  

 

 

 

 

Název 

obce 

Typ ústředny/                   

typ rozhlasu 

Výkon 

ústředny 

Počet 

reproduktorů 

Ozvučení 

obce [%] 

Způsob ovládání 

rozhlasu 

Moravská 

Třebová 
VISO 2002  kanál BMIS 2W 190 95 

Dálkové, KOPIS HZS 

PaK 

Linhartice MIR-01 Empemont 2W 50 100 
Manuální z obecního 

úřadu 

Obec Evakuační středisko Ulice Kapacita 

osob 

Spojení 

(tel./mobil) 

Moravská Třebová Střední technická škola 

Ministerstva obrany 

Jevíčská 7 800 461318297/ 

602185316 

Linhartice Střední technická škola 

Ministerstva obrany 

Jevíčská 7 800 461318297/ 

602185316 
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Tab. 9:  Podrobné informace o zdravotním centru v Moravské Třebové (zdroj: HZS 

Pardubického kraje) 

 

3.3 Důležité pojmy v oblasti ochrany obyvatelstva  

Mimořádná událost 

Mimořádnou událostí se dle zákona č. 239/2000 Sb. rozumí: „Škodlivé působení sil 

a jevů vyvolaných činností člověka, přírodními vlivy, ale také havárie, které 

ohrožují život, zdraví, majetek, nebo životní prostředí a vyžadují provedení záchranných 

a likvidačních prací.“ Obecně lze za mimořádnou událost považovat náhlou 

závažnou událost, která způsobila narušení stability systému s možným ohrožením jeho 

bezpečnosti nebo existence. 

Ohrožující objekty 

Ohrožujícím objektem se z pohledu ochrany obyvatelstva rozumí objekt, který ke své 

činnosti využívají nebezpečné látky. Jedná se především o čistírny odpadních vod, 

průmyslové areály, skládky, čerpací stanice apod. (Kořínek, 2011, ústní sdělení) K těmto 

objektům se musí přistupovat s obezřetností při výskytu mimořádné události, a proto 

značně komplikuje zásah HZS. 

Významné objekty 

Významným objektem se naopak oproti ohrožujícím objektům rozumí objekt, který 

pro svou činnost nevyužívá žádné nebezpečné látky, ale svou rozlohou a možnou 

kapacitou může shromažďovat více lidí na jednom místě (Kořínek, 2011, ústní sdělení). 

Takovýmito objekty se rozumí např.: domovy pro seniory, školy, nemocnice, 

supermarkety apod. Z hlediska evakuace, plánování nouzového ubytování, stravování je 

nutné znát tyto významné objekty i s počty lidí shromážděných v těchto objektech a 

taktéž se k nim musí přistupovat při mimořádné události s větší pozorností nežli u 

ostatních objektů.  

Bližší specifikace ohrožujících, či významných objektů se v zákonech o integrovaném 

systému, krizovém řízení, nebo požární ochraně nenachází, proto byly definice těchto 

dvou pojmů stanoveny na základě konzultací s Mgr. Kamilem Kořínkem, pracovníkem 

oddělení ochrany a přípravy obyvatelstva odboru ochrany obyvatelstva a krizového řízení 

Krajského ředitelství HZS Olomouckého kraje.  

Obec 
Název 

organizace 

Adresa 

Telefon 

Lůžková kapacita 

zdravotnického 

zařízení 

Zaměstnanci 

celkem Ulice Č. p. 

Moravská 

Třebová 

Nemocnice 

následné péče 
Svitavská 25 461 352 222 90 134 

http://cs.wikipedia.org/wiki/Jev
http://cs.wikipedia.org/wiki/%C4%8Clov%C4%9Bk
http://cs.wikipedia.org/wiki/Hav%C3%A1rie
http://cs.wikipedia.org/wiki/%C5%BDivot
http://cs.wikipedia.org/wiki/Zdrav%C3%AD
http://cs.wikipedia.org/wiki/Majetek
http://cs.wikipedia.org/wiki/%C5%BDivotn%C3%AD_prost%C5%99ed%C3%AD
http://cs.wikipedia.org/wiki/Ud%C3%A1lost
http://cs.wikipedia.org/w/index.php?title=Stabilita_syst%C3%A9mu&action=edit&redlink=1
http://cs.wikipedia.org/w/index.php?title=Bezpe%C4%8Dnost&action=edit&redlink=1
http://cs.wikipedia.org/wiki/Existence
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Jednotky požární ochrany (JPO) 

Ze zákona č. 133/1985 Sb. vyplývá, že JPO je organizovaný systém tvořený odborně 

vyškolenými osobami, požární technikou a věcnými prostředky požární ochrany, který 

v případě vzniku mimořádných událostí by byl k plnění úkolů záchranných a likvidačních 

prací doplněn o další profesionální jednotky HZS (v zájmovém území HZS Pardubického 

kraje) a jednotky požární ochrany z okolních obcí v souladu s poplachovým plánem IZS 

(Integrovaného záchranného systému). Základním úkolem těchto jednotek je chránit 

životy a zdraví obyvatel a jejich majetku před požáry a poskytovat pomoc při 

mimořádných událostech. JPO se dle druhu jednotky a operační hodnoty (doba výjezdu, 

územní působnost, počet jednotek) dělí do šesti kategorií na JPO I až JPO VI. Každá 

z těchto kategorií má jiný význam JPO I – jednotka Hasičského záchranného sboru ČR, 

JPO V –  jednotka požární ochrany sboru dobrovolných hasičů obce. Podrobnější 

informace o JPO v obcích Moravská Třebová a Linhartice jsou uvedeny v Tab. 10. 

 

Tab. 10: Seznam JPO v Moravské Třebové a Linharticích (zdroj: HZS Pardubického kraje) 

Název jednotky Kategorie 

JPO 

Nadřízená JPO Zřizovatel Adresa zřizovatele 

Moravská 

Třebová 

JPO II Moravská Třebová Město Moravská Třebová T. G. Masaryka 29 

Moravská 

Třebová - Boršov 

JPO V Moravská Třebová Město Moravská Třebová T. G. Masaryka 29 

Moravská 

Třebová - Sušice 

JPO V Moravská Třebová Město Moravská Třebová T. G. Masaryka 29 

Moravská 

Třebová - Udánky 

JPO V Moravská Třebová Město Moravská Třebová T. G. Masaryka 29 

Linhartice JPO V Moravská Třebová Obec Linhartice Linhartice 134 
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4 SOUČASNÝ STAV ŘEŠENÉ PROBLEMATIKY 

4.1  Hydrodynamické modelování v literatuře 

Modelováním hydrologických procesů se v současné době zabývá řada odborníků. 

Většina z nich se však zabývá modelováním srážko-odtokovým, nežli hydrodynamickým. 

Pro tvorbu bakalářské práce byly prostudovány např. následující publikace popisující 

modelování protržení hrazení VD:  

 Dam breach reconstruction of the Blažňov pond caused by extreme 

hydrological event, M. Šobr, 2008 

 A Dam Break Analysis Using HEC-RAS, Y. Xiong, 2011 

V těchto dílech jsou popsány metody a postupy řešení modelování protržení VD. 

Dalšími publikacemi, které byly prostudovány, ale nesouvisí přímo s modelováním 

protržení hráze, jsou díla popisující hydraulické modelování a díla zabývající se 

modelováním v prostředí programu HEC-RAS, např.: 

 Hydrologic and Hydraulic: modeling support with geographic information 

systems, D. Maidment, 2000 

 Floodplain modeling using HEC-RAS, G. Dayhouse, 2003 

 HEC-RAS River Analysis System User´s Manual v. 4.1.0, G. W. Banner, 

2010 

  Z českých autorů se okrajově této problematice hydrodynamického modelování 

věnuje RNDr. Michal Jeníček, Ph.D. z Karlovy Univerzity v Praze ve svém díle: Využití 

GIS v hydrologických a hydrodynamických modelech z roku 2007, dále pro lepší 

pochopení jednotlivých pojmů z oblasti hydrauliky bylo použito dílo: Hydraulika a 

hydrologie doc. Ing. Jana Jandory, Ph.D. z roku 2005.  

Obdobnou problematikou se zabývaly Ing. Kateřina Casáková ze Stavební fakulty 

VUT v Brně ve své diplomové práci z roku 2004 na téma: Řešení zvláštní povodně pod 

VD Boskovice, kde se zabývá matematickým modelováním zvláštní povodně, a Bc. 

Lenka Čermáková z Lesnické a dřevařské fakulty Mendelovy Univerzity v Brně také v 

diplomové práci s názvem: Modelování n-letých průtoků vodního toku Dědiny pomocí 

softwaru HEC-RAS.  

 

4.2 Extremní hydrologické jevy 

Mezi nejznámější extrémní hydrologické jevy patří povodně a zátopa, opakem a méně 

známým jevem je hydrologické sucho, které způsobuje pokles hladiny podzemní vody. 

Dle zákona č. 254/2001 Sb. o vodách a o změně některých zákonů (vodní zákon) je 

povodní přechodné výrazné zvýšení hladiny vodních toků nebo jiných povrchových vod, 

při kterém voda zaplaví území mimo koryto vodního toku a může tak způsobit škody. 

Povodní je i stav, kdy voda působí škody tím, že z určitého území nemůže dočasně 

přirozeným způsobem odtékat (odtok je nedostatečný), případně dochází k zaplavení 

http://web.natur.cuni.cz/ksgrrsek/acta/2008/sobr.pdf
http://web.natur.cuni.cz/ksgrrsek/acta/2008/sobr.pdf
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území při soustředěném odtoku srážkových vod. Povodeň může být způsobena 

přírodními jevy, zejména táním, dešťovými srážkami nebo chodem ledů (přirozená 

povodeň), nebo jinými vlivy, zejména poruchou vodního díla, která může vést až k jeho 

havárii (protržení) nebo nouzovým řešením kritické situace na vodním díle (zvláštní 

povodeň). 

 Podle ČSN 75 0101 je povodňová vlna vlnou průtokovou s charakterem povodní a 

průtoková vlna znamená přechodné zvětšení a následný pokles průtoků a vodního stavu 

vyvolaný dešti, táním sněhu nebo umělým zásahem. 

 

Parametry zvláštních povodní 

Zvláštní povodeň je definována jako povodeň způsobená umělými vlivy. To jsou 

situace, jež mohou nastat při stavbě nebo provozu vodohospodářských děl, která 

vzdouvají nebo mohou vzdouvat vodu zejména při (toto dělení vyplývá z díla Posudek 

bezpečnosti vodního díla za povodní, 2000): 

 Narušení vzdouvacího prvku vodohospodářského díla (označení ZPV1). 

 Porušení hradících bezpečnostních konstrukcí nebo výpustních zařízení 

vodohospodářských děl (označení ZPV2). 

 Nouzové řešení kritických situací z hlediska bezpečnosti vodohospodářského díla 

(označení ZPV3). 

Zvláštní povodně jsou často spojeny s výskytem povodní přirozených v daném území. 

Tato extrémní situace se nejčastěji týká zemních hrází malých nádrží a rybníků. Studie 

dle Middlebrooka (1953) ukazuje nejčastější příčiny částečného či úplného porušení 

zemních sypaných, či kamenitých hrází, kterými jsou: Přelití (30 %), vnitřní eroze (25 

%), sesuv (15 %), netěsnost potrubních výpustí (13 %), úprava (dláždění) svahu (5 %), 

různá (7 %), neznámá (5 %). 

V díle Posudek bezpečnosti vodního díla za povodní (2000) jsou k vodnímu dílu 

Moravská Třebová řešeny všechny možnosti způsobení zvláštní povodně. Jako první je 

řešeno narušení vzdouvacího prvku vodohospodářského díla (ZPV1), které může být 

způsobeno erozí hráze při jejím přelití. Do ZPV1 řadíme ještě zvláštní povodeň 

způsobenou vnitřní erozí hráze. Vnitřní eroze je řešena v 7 různých variantách (každá má 

počátek poruchy v různých výškách nádrže od 354,20 m n. m. po 357,20 m n. m.). 

Nejvyšší kulminační průtok (QZPV1=142,6 m
3
s

-1) pod hrází má varianta poruchy vzniklé 

ve střední části hráze (357,20 m n. m.), což způsobí 100-letou povodeň. 

Jako ZPV2 je uvažována porucha jedné spodní výpusti při jejím plném otevření, která 

způsobí zvláštní povodeň s kulminačním průtokem QZPV2=7,67 m
3
s

-1
, což je průtok menší 

než neškodný QN=10 m
3
s

-1
. Dále jako ZPV2 se uvažuje náhlé vyhrazení bezpečnostního 

přelivu délky 15 m, což zapříčiní neškodnou zvláštní povodeň s průtokem QZPV2=8,35 

m
3
s

-1
.V tomto díle je uvažována jako ZPV3 havarijní vypouštění plnou kapacitou obou 

spodních výpustí. Kulminační průtok bude QZPV3=15 m
3
s

-1
 a to je cca 10-letá voda. Při 

této poruše se již vyhlašuje II. stupeň povodňové aktivity. 
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4.3 Hydrologické modely 

Model je zjednodušením skutečné reality. Reprezentuje určitý objekt nebo spojitý 

systém v prostoru a čase. Je to zmenšená realita, převedená do formy, kterou můžeme 

pochopit. Clarke (1973) chápe model v matematickém vyjádření jako algoritmus řešení 

soustavy rovnic, které popisují strukturu a chování systému.  

Hydrologický model lze popsat jako matematický model srážko-odtokového procesu 

představující zjednodušený kvantitativní vztah mezi vstupními a výstupními veličinami 

určitého hydrologického systému (Daňhelka, 2003).  

 

4.3.1 Klasifikace hydrologických modelů 

Zjednodušeně lze hydrologické modely rozdělit na srážko-odtokové modely (s-o 

modely) a hydrodynamické modely (HD modely). S-o modely mají svou aplikaci 

v operativní hydrologii, kdy vstupními daty jsou mimo stavových veličin také okamžité 

údaje z radaru nebo meteorologických stanic. Oproti tomu HD modely slouží především 

pro dlouhodobé předpovědi, např. řešení protipovodňových opatření, řešení umístění 

technických staveb na vodním toku atd. Podrobnější klasifikací a vývojem 

hydrologických modelů se ve svých pracích zabývalo v minulosti mnoho autorů, např.: 

Beven (2001), Blöschl a Grayson (2002). Modely používané v hydrologii lze rozlišit 

mnoha způsoby, např. Daňhelka (2007) rozděluje modely dle prostorové diskretizace na:  

 Celistvé modely (lumped modely) – parametry charakterizující dané povodí se 

vztahují k celému nebo dílčímu povodí (bodově měřené hodnoty jsou 

nejrůznějšími geostatistickými metodami převedeny na hodnoty plošné). 

 Distribuované modely – uvažují prostorovou variabilitu vstupních parametrů, 

povodí je rozděleno na síť (grid) a každé políčko gridu má svou charakteristickou 

hodnota parametru. 

 Semi-distribuované modely – kombinace dvou výše uvedených modelů. 

 

4.3.2 Modely rodiny HEC 

HEC (The Hydrologic Engineering Center) bylo založeno v roce 1964 jako 

inženýrské centrum armády USA – US Army Corps of Engineers zabývající se hlavně 

vývojem hydrologických softwarů. Mezi nejznámější programy patří: 

 

HEC-RAS 

HEC-RAS (River Analysis System) je jednorozměrný hydrodynamický model 

umožňující řešení stromových i okružních sítí přirozených otevřených koryt včetně 

příčných a podélných objektů na toku, dále umožňuje výpočet nerovnoměrného proudění 

v korytě a to jak v ustáleném, tak v neustáleném režimu metodou po úsecích (Šobr, 

2008). Pro výpočet proudění využívá HEC-RAS Saint-Venantových rovnic neustáleného 



22 

proudění. Dále lze v modelu nadefinovat odpory koryta na jednotlivých dílčích profilech, 

a proto mohou mít tyto profily proměnlivou drsnost. Toto je řešeno buďto Manningovým 

součinitelem drsnosti, nebo lze využít i parametr zrnitostního složení materiálu dna. 

HEC-RAS lze kombinovat s programem HEC-GeoRAS, který je extenzí (nástrojovým a 

aplikačním rozšířením) pro software ArcGIS, která umožňuje přípravu a následný export 

geodetických dat. HEC-RAS je nyní dostupný ve verzi 4.1 a jako všechen ostatní 

software HEC (The Hydrologic Engineering Center) je volně k dispozici na stránkách US 

Army Corps of Engineers (http://www.hec.usace.army.mil/).   

 

HEC-HMS 

HEC-HMS (Hydrologic Modeling System) je jeden z nejvíce celosvětově rozšířených 

srážko-odtokových modelů. HEC-HMS je především celistvý (lumped) model. Tento 

program dokáže využívat mnoho metod používaných jak v hydrologii, tak v hydraulice. 

Obecně do srážko-odtokového modelu vstupuje několik základních faktorů, jinak tomu 

není ani u HEC-HMS. Do modelu mohou vstupovat srážky, jak dešťové, tak sněhové, ve 

formě časových řad, nebo plošného úhrnu těchto srážek, dále evapotranspirace a 

intercepce. Důležitým faktorem je povrchový a podpovrchový odtok z povodí, pro odtok 

v korytě jsou k výpočtům stejně jako u HEC-RAS využívány Saint-Venantovy rovnice. 

HEC-HMS obsahuje komponenty popisující jednotlivé procesy srážko-odtokového 

procesu: Meteorologický model (Meteorological Model), Model objemu odtoku (Runoff 

Volume Model), Model přímého odtoku (Direct Runoff Model), Model podzemního 

odtoku (Baseflow Model), Korytový model (Channel Model) a ostatní komponenty 

(model výpočtu nádrže, kanálu, odběru vody atd.) (Jeníček, 2007). HEC-HMS lze stejně 

jako HEC-RAS doplnit o extenzi HEC-GeoHMS sloužící k přípravě a exportu vstupních 

dat. Tento software má stejně jako ostatní programy HEC (Hydrologic Engineering 

Center) freeware licenci.  

 

4.3.3 Ostatní modely 

HYDROG – Sovina (2010) popisuje tento program jako srážko-odtokový distributivní 

model společnosti HySoft, který byl vyvinut k simulaci, operativní předpovědi a 

operativnímu řízení odtoku vody z daného povodí.  

MIKE SHE – jeden z nejrozšířenějších a nejpoužívanějších komerčních programů 

dánské firmy DHI. Jedná se o dynamický semi-distribuovaný srážko-odtokový model, 

který má širokou oblast uplatnění, využití pro analýzu, plánování a řízení v oblasti 

vodohospodářství a životního prostředí (Prucha, 2012).  

MIKE 11 – světově nejrozšířenější komerční matematický jednorozměrný 

hydrodynamický model, jehož distributorem je taktéž firma DHI. Model umožňující 

simulaci proudění, kvality vody a pohybu splavenin v otevřených korytech, je vhodný při 

řešení protipovodňové ochrany, vývoje kvality vody a řízení vodohospodářských objektů 

(Prucha, 2012).  

http://www.hec.usace.army.mil/
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AquaLog – jedná o matematický semi-distributivní model vyvinutý společností 

AquaLogic Consulting, s.r.o.  

Další modely: SMODERP (Simulační model povrchového odtoku a erozního 

procesu), INFIL/KINFIL (modely pro odhadování maximálního odtoku z povodí 

způsobené přívalovými dešti), LOREP (slouží k identifikaci a prostorové lokalizaci ploch 

s nízkou retencí)… 

 

4.4 Modelování ustáleného a neustáleného proudění v korytě 

Ustálené proudění je dle Jandory (2011) takové proudění, kdy jsou hydraulické 

veličiny (průtok, průřezová rychlost, průtočná plocha) v čase neměnné a závisí tedy 

pouze na poloze, dále blíže specifikuje rovnoměrné a nerovnoměrné proudění jako: 

 Rovnoměrné - zvláštní případ ustáleného proudění, při kterém jsou průtočné řezy 

na celém úseku konstantní. Dále je i konstantní průtok, a proto jsou konstantní i 

průřezové rychlosti. Tento případ nastává při konstantním sklonu dna koryta, 

neměnných příčných profilech a drsnosti vedení. V reálném světě je tento jev 

málo pravděpodobný, ale v oblasti matematického modelování lze v některých 

případech tímto prouděním nahradit reálné nerovnoměrné proudění. 

 Nerovnoměrné – proudění, u kterého jsou hydraulické veličiny konstantní v čase, 

ale průřezová rychlost a průtočná plocha se mění po délce proudu, což je dáno 

např.: proměnným sklonem dn, proměnných příčných profilech a drsnostech. 

Ve většině softwarů zabývajících se hydrologickým modelováním ustáleného 

rovnoměrného, či nerovnoměrného proudění je tento jev metodicky řešen pomocí 

kombinací rovnic výpočtu rychlosti proudění (Chézyho, Mnningovou, nebo Darcy-

Weisbachovou rovnicí) spolu s rovnicí kontinuity.  

 

Chézyho rovnice (vztah pro výpočet rychlosti vody v otevřeném korytě): 

  

 

kde: v - rychlost (m.s
-1

),  

R - hydraulický poloměr (m),  

i - sklon čáry energie, 

C - Chézyho rychlostní součinitel (m
0,5

.s
-1

) 

 

Manningova rovnice (empirický vztah pro výpočet rychlosti proudění v otevřeném 

korytě): 

 

 

kde: n - Manningův drsnostní součinitel (s.m
-1/3

),  

iRCv 

2

1

0
3

2
1

iR
n

v 

http://cs.wikipedia.org/wiki/Rychlost
http://cs.wikipedia.org/wiki/Hydraulick%C3%BD_polom%C4%9Br
http://cs.wikipedia.org/w/index.php?title=%C4%8C%C3%A1ra_energie&action=edit&redlink=1
http://cs.wikipedia.org/wiki/Ch%C3%A9zyho_rychlostn%C3%AD_sou%C4%8Dinitel
http://cs.wikipedia.org/w/index.php?title=Empirick%C3%BD_vztah&action=edit&redlink=1
http://cs.wikipedia.org/wiki/Rychlost
http://cs.wikipedia.org/w/index.php?title=Drsnostn%C3%AD_sou%C4%8Dinitel&action=edit&redlink=1
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R - hydraulický poloměr (m),  

i0 - sklon dna 

 

Tyto rovnice se musí kombinovat s rovnicí kontinuity vyjadřující průtok: 

  

 

kde: Q - průtok (m
3
s

-1
),  

 v - rychlost (m.s
-1

),  

 S - průtočná plocha (m
2
) 

 

Neustálené proudění – průtok se oproti ustálenému mění jak v čase, tak i v prostoru 

(Jandora, 2011). Rovnice popisující neustálené proudění se mění v závislosti na tom, 

zdali se jedná o hydrologické modely jednorozměrné, dvourozměrné, či třírozměrné 

(Daňhelka, 2007):  

 Třírozměrné modely (3D) – modely ve 3D jsou obecně popsány tzv. Navier-

Stokesovými rovnicemi, což je soustava 4 rovnic, z nichž je jedna rovnice rovnicí 

kontinuity a tři rovnice reprezentující 3 pohybové rovnice ve třech směrech os 

kartézského souřadného systému 

 Dvourozměrné modely (2D) – popsáno pomocí Reynoldsových rovnic 

turbulentního proudění, kterou tvoří soustava tří rovnic, z toho dvou rovnic 

pohybových ve směrech x1 a x2 a rovnice kontinuity 

 Jednorozměrné modely (1D) – popsáno pomocí Saint-Venantových rovnic 

 

U 1D modelu, který byl použit i v rámci bakalářské práce, je výpočet založen na 

řešení dvou diferenciálních rovnic, tzv. Saint Venantových rovnic: 

 

a) rovnice kontinuity, která je po úpravách použita ve tvaru: 

 

                           

 

kde: A- průřezová plocha (m2),  

  t - čas (s),  

 Q - průtok (m3.s-1),  

 x - podélný rozměr (m),  

 q - boční přítok na jednotku délky (m
2
.s

-1
) 

 

 

0 q
x

Q

t

A









SvQ 

http://cs.wikipedia.org/wiki/Hydraulick%C3%BD_polom%C4%9Br
http://cs.wikipedia.org/wiki/Rychlost
http://cs.wikipedia.org/wiki/Pr%C5%AFto%C4%8Dn%C3%A1_plocha
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b) rovnice hybnosti vycházející z druhého Newtonova zákona je po úpravě použita ve 

tvaru: 

  

 

 

 

kde:  A - průřezová plocha (m
2
),  

t - čas (s),  

Q - průtok (m
3
.s

-1
),  

x - podélný rozměr (m),  

q - boční přítok na jednotku délky (m
2
.s

-1
),  

vp - rychlost ve směru přítoku, který uzavírá se směrem toku úhel φ (m. s
-1

),  

i0 - sklon dna,  

ie - sklon čáry energie,  

g - tíhové zrychlení (m.s
-2

),  

y - střední hloubka (m),  

φ - úhel mezi hlavním směrem proudu a směrem přítoku (°) 
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5 METODY A POSTUP ZPRACOVÁNÍ 

V této kapitole jsou shrnuty veškeré použité programy, získaná data potřebná 

k následné modelaci povodňové vlny a stručný postup jednorozměrného modelování. 

 

5.1 Použité programy 

Software firmy ESRI resp. ESRI ArcGIS 10 s licencí ArcInfo, která pomocí sady 

nástrojů umožňuje pokročilé zpracovávání prostorových dat, tvorbu kartografických 

výstupů a řešení analytických úloh. Pro preprocessing prostorových dat byly použity 

extenze 3D Analyst Tools sloužící k modelování trojrozměrných povrchů a jejich 

následnou vizualizaci a Spatial Analyst Tools, který slouží taktéž k prostorovému 

modelování, ale i k analýze těchto prostorových dat. 

HEC-GeoRAS 10 je extenze (nástrojové a aplikační rozšíření) softwaru ArcGIS 

umožňující zpracování prostorových dat se zaměřením na vodohospodářské využití. 

Extenze je zaměřena na preprocessing dat vstupujících do softwaru HEC-RAS a jejich 

následný export, který funguje i opačně, kdy výsledky kalkulací lze zpětně převést do 

aplikací GIS a následně je zvizualizovat. HEC-GeoRAS musí být použit v kompatibilní 

verzi v závislosti na softwaru ESRI (např.: HEC-GeoRAS 10 pro ArcGIS 10). HEC-

GeoRAS je volně k dispozici na stránkách US Army Corps of Engineers 

(http://www.hec.usace.army.mil/software/hec-ras/hec-georas_downloads.html).   

HEC-RAS 4.1.0 (River Analysis System) je software řešící jednorozměrné 

hydraulické kalkulace proudění v síti přirozených koryt i umělých kanálů. Možnosti a 

metody, které používá software HEC-RAS jsou popsány v kapitole 3.3.2. Stejně jako 

HEC-GeoRAS je možné tento software volně stáhnout na stránkách US Army Corps of 

Engineers (http://www.hec.usace.army.mil/software/hec-ras/hecras-download.html). 

 

5.2 Data 

Mezi základní vstupní data, která byla použita k přípravě vrstev nutných pro vstup 

(viz Kap. 5.1) do modelovacího programu HEC-RAS k modelování povodňové vlny při 

destrukci VD Moravská Třebová a následnému posouzení dopadů, patří především 

vektorová data ve formátu ESRI shapefile. Jedná se o 2 mapové listy (14-34-20, 14-43-

16) ZABAGED obsahující polohopisná data, u kterých přesnost odpovídá přesnosti 

Základní mapě České republiky 1:10 000 (ZM 10), což je 3-10 m (popis jednotlivých 

vrstev polohopisné části dat je v Příloze 1) a tytéž stejné mapové listy ZABAGED 

obsahující výškopisný grid 10×10 m, u kterých poslední aktualizace výškopisných bodů 

proběhla v roce 2010 u mapového listu 14-34-20 a mapového listu 14-43-16 v roce 2012, 

Přesnost výšky naměřených bodů výškopisného gridu je závislá na sklonu a členitosti 

terénu a dosahuje 0,7-1,5 m v odkrytém terénu, 1-2 m v sídlech a 2-5 m v zalesněném 

terénu. Tato data jsou na úrovni podrobnosti Základní mapy ČR 1:10 000. Výškopisný 

grid 10×10 m byl použit pro tvorbu DMT. Polohopisná i výškopisná data ZABAGED 

http://www.hec.usace.army.mil/software/hec-ras/hec-georas_downloads.html
http://www.hec.usace.army.mil/software/hec-ras/hecras-download.html
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byla poskytnuta Českým úřadem zeměměřičským a katastrálním pouze pro účely této 

bakalářské práce. Výškopisná data sloužila k tvorbě DMR, resp. spolu s polohopisnou 

vrstvou budov, bloků budov ke tvorbě DSM. Ostatní vrstvy z polohopisné části 

ZABAGED sloužily ke kartografické vizualizaci.  

K dalším datům použitým v této práci patří DIBAVOD v měřítku 1:10 000, jejímž 

poskytovatelem byl Výzkumný ústav vodohospodářský T. G. Masaryka, konkrétně z této 

databáze byl použit polygon záplavového území stoleté vody, hydrologického členění – 

povodí IV. řádu a liniová vrstva vodních toků, všechny tyto vrstvy jsou taktéž ve formátu 

ESRI shapefile s polohovou přesností 5-10 m a poslední aktualizací těchto vrstev ze dne 

22.2.2011. Všechny tyto vrstvy jdou volně stažitelné z databáze DIBAVOD ve formátu 

SHP (komprese ZIP) na stránkách Výzkumného ústavu vodohospodářského T. G. 

Masaryka dostupných z: http://www.dibavod.cz/27/struktura-dibavod.html. Liniová 

vrstva vodních toků spolu s ortofotomapou CENIA sloužila k určení osy toku řeky 

Třebůvky, polygon záplavového území stoleté vody sloužil k predikci možné hranice 

záplavového území po úplné destrukci VD Moravská Třebová a polygon hydrologického 

členění posloužil pouze k vymezení a vizualizaci zájmového území. 

ZABAGED i DIBAVOD jsou v souřadnicovém systému S-JTSK Krovak EastNorth. 

Kromě výše zmíněných dat byly použity ještě výkresy geodeticky zaměřených příčných 

profilů obsahující i mosty a jiné překážky na vodním toku Třebůvka poskytnutých 

státním podnikem Povodí Moravy pouze pro účely této bakalářské práce. Tyto výkresy, 

které byly použity ke zpřesnění koryta řeky Třebůvky (viz Kap. 5.2), jsou ve formátu 

DXF (Drawing Exchange Format) v měřítku 1:500, resp. 1:1000 a výškovém systému 

Balt p.v., konkrétně se jedná o čísla výkresu C.3.38 až C.3.51 a byly vytvořeny v dubnu 

2003.  

Dalšími daty poskytnutými státním podnikem Povodí Moravy pro účely této práce 

byly hodnoty průtoků ve formě tabulky. Tyto průtoky jsou predikovány pro poruchu VD 

Moravská Třebová s následným postupným a úplným protržením hrazení s počátkem 

sufoze ve výšce 357,20 m n. m. Tabulka obsahuje hodnoty celkového odtoku z nádrže, 

objemu odteklé vody a vývoj hladiny v podhrází (viz Příloha 2). Lokace tohoto vývoje 

odtoku při destrukci hrazení VD Moravská Třebová je pro spodní výpusť tohoto vodního 

díla. Tato data byla použita jako horní okrajová podmínka při zadávání hydrologických 

dat neustáleného proudění (viz kap. 5.2).    

 

 

 

 

 

 

 

 

http://www.dibavod.cz/27/struktura-dibavod.html
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5.3 Postup zpracování 

Postup zpracování bakalářské práce lze shrnout do několika kroků: 

1. Studium literatury  

Před vlastním praktickým zpracováním bakalářské práce byla provedena literární 

rešerše na základě studia odborných pramenů (viz kap. 4.1) 

2. Tvorba DMR se zahrnutím výšek budov v daném území do tohoto DMR 

Pro tvorbu DMR byla použita metoda Delaunay triangulace, kdy uvnitř kružnice 

opsané libovolnému trojúhelníku neleží žádný jiný bod z dané množiny (více 

informací lze nalézt v literatuře např. Voženílek, 1998) nad datovou vrstvou 

z databáze ZABAGED výškopisný grid 10×10 m. Tento DMR byl doplněn o výšky 

objektů, které by mohly bránit rozlivu (např. budovy, bloky budov, válcové 

nádrže…). 

3. Pre-processing geometrických dat koryta toku a záplavového území z DSM, které 

budou sloužit jako vstup do výpočtového 1D modelu HEC-RAS  

4. Import vytvořených dat do HEC-RAS, jejich úprava, přidání dalších parametrů a 

následné spuštění výpočtu neustáleného proudění 

HEC-RAS používá pro výpočet ustáleného proudění kombinaci Manningovy 

rovnice s rovnicí kontinuity a hybnosti (viz kap. 4.4), pro neustálené proudění 

používá tento software tzv. Saint-Venantovy rovnice (viz kap. 4.4). 

5. Export výsledků výpočtu zpět z HEC-RAS do ArcGIS (HEC-GeoRAS) a vytvoření 

map záplavových území   

Pro vizualizaci do map byly použity kartografické metody. Mimo mapy byly 

vytvořeny grafy a tabulky pro popis časových změn.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 



29 

6 MODELOVÁNÍ PROTRŽENÍ HRÁZE VD MORAVSKÁ 

TŘEBOVÁ 

V této kapitole je popsán postup při přípravě a předzpracování dat pro vstup do 

modelačního programu a následné zpracování dat při modelování povodňové vlny 

způsobené postupnou úplnou destrukcí VD Moravská Třebová. 

 

6.1 Práce v programu ArcGIS 10 

Tvorba DMR 

Jako podklad při tvorbě DMR sloužil výškopisný grid 10×10 m ZABAGED, ze 

kterého byl vytvořen TIN pomocí funkce 3D Analyst Tools → TIN Management → 

Create TIN v územním rozsahu obcí Moravská Třebová a Linhartice. Dále tento TIN byl 

převeden na raster o velikosti pixlu 1×1 m pomocí funkce 3D Analyst Tools → 

Conversion → From TIN → TIN to Raster. Zprvu byl vytvořen TIN z toho důvodu, že 

DMR ve formě TINu lépe zachovává terénní hrany, což je v oblasti hydrologie velmi 

důležité. Pro následné analýzy však bylo lepší jej převést na raster o velikosti pixlu 1×1 

m. Tato velikost pixlu byla zvolena kvůli pozdějšímu přičtení rastru s výškami staveb, 

kde bylo potřeba zachytit i menší stavby (např.: kůlny…), které nejsou tak rozlehlé. 

Z polohopisných dat ZABAGED z vrstev BudovaBlokBudov.shp, 

KulnaSklenikFoliovnik.shp, PrecerpavaciStaniceProduktovodu.shp, 

RozvodnaTransformovna.shp a ValcovaNadrzZasobnik.shp byla vytvořena nová 

polygonová vrstva ve stejném prostorovém rozsahu jako rastrový DMR. Jednotlivým 

kategoriím byl přiřazen výškový atribut na základě územních plánů jednotlivých obcí, 

dostupných na webových stránkách města Moravská Třebová (http://www.mtrebova.cz/) 

a obce Linhartice (http://www.linhartice.cz/), viz Tab. 11. Tam, kde se nenachází žádná 

stavba, byla polygonu přidělena výška 0. Tato polygonová vrstva byla poté převedena na 

raster o stejné velikosti pixlu jako DMR (1×1 m) pomoci funkce Conversion Tools → 

To Raster → Polygon to Raster na základě atributu vyska. Poté byl rastr staveb pomocí 

funkce Spatial Analyst Tools → Math → Trigonometric → Plus  přičten k prvnímu 

rastru DMR vytvořenému pouze z výškových bodů gridu ZABAGED. S takto 

vytvořeným rastrem částečného digitálního modelu povrchu DSM lze přejít na přípravu 

ostatních dat vstupujících do programu HEC-RAS. Na Obr. 3 je zobrazen DMT a z něho 

vytvořený DSM. Při tvorbě DSM byl DMR navýšen pouze o stavby, jelikož se v daném 

území z vegetace, která by mohla ovlivnit rozliv, nachází pouze skupinky stromů, či keřů 

vyskytujících se podél části řeky Třebůvky, ale po konzultaci se zástupci Povodí Moravy 

s. p. byla tato vegetace vynechána u tvorby DSM, protože nemá při úplné destrukcí 

hrazení VD Moravská Třebová téměř žádný vliv na následný rozliv. 

 

 

 

http://www.mtrebova.cz/
http://www.linhartice.cz/
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Tab. 11: Kategorie staveb a k nim přiřazené výšky (zdroj údajů o výšce objektů – územní plán 

města Moravská Třebová a obec Linhartice) 

Druh stavby Výška [m] 

Bez budov 0 

Budova čistírny odpadních vod 5 

Budova nemocnice 15 

Budova průmyslového podniku 12 

Budova skládky 4 

Budova STŠ MO - ev. Středisko 18 

Čerpací stanice 10 

Kaple 10 

Kostel 10 

Kůlna, skleník, foliovník 3 

Kulturní objekt 15 

Obytný dům 20 

Poštovní úřad 10 

Přečerpávací stanice 3 

Rodinný dům 6 

Rozvodovna el. energie 4 

Správní a soudní budova 12 

Supermarket 7 

Škola, školská zařízení 10 

Tepelná elektrárna 4 

Válcová nádrž 3 

 

 

Obr. 3: Rozdíl mezi DTM (vlevo) a DSM (vpravo) 

 

Preprocessing geometrických dat 

Za pomocí extenze HEC-GeoRAS pro software ArcGIS v. 10 (viz Obr. 4) byly 

vytvořeny vrstvy dat, které následně vstupovaly do modelování v HEC-RAS. Je to 

především vrstva definující osu daného toku (Stream Centerline), dále vrstva definující 

břehy daného toku (Bank Lines), vrstva hranic definujících protékané oblasti (Flow Path 

Centerlines) a příčné profily (XS Cut Lines). HEC-GeoRAS umožňuje vytvoření i oblasti 

neefektivního prouděni (Ineffective Flow Areas), mostů či propustků (Bridges/Culverts) a 

dalších vrstev, ale těchto možností nebylo využito. Nástroje pro zakreslení křivek 
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vymezujících osu toku, příčné profily, břehy toku a směry proudění vody  lze nalézt v 

menu RAS Geometry → Create RAS Layers extenze GeoRas (Obr. 4).  

 

 

Obr. 4: Extenze HEC-GeoRAS v uživatelském prostředí ArcGIS 10 

Jako první je nutné zakreslit osu toku což je liniová vrstva, která vyznačuje střednici 

námi zvolené řeky. Pro vytvoření této vrstvy byl použit nástroj: Ras Geometry → 

Create RAS Layers → Stream Centerline, a následně do dialogového okna byl uveden 

název vrstvy pro zakreslení osy toku (zde: River). Osa toku na řece Třebůvce byla 

digitalizována ručně nad barevnou ortofotomapou České informační agentury životního 

prostředí CENIA s prostorovým rozlišením 50 cm připojenou pomocí WMS služby 

dostupné z Mapových služeb Portálu veřejné správy (MS PVS) na adrese: 

http://geoportal.gov.cz/ArcGIS/services/CENIA/cenia_rt_ortofotomapa_aktualni/mapser

ver/WMSServer? a vrstvou vodních toků databáze DIBAVOD. Poslední aktualizace této 

ortofotomapy ve vymezeném území proběhla v roce 2008. Digitalizace probíhala 

v editačním režimu programu ArcMap v měřítku 1:100 až 1:200. Na řece Třebůvce byla 

osa toku digitalizována od říčního staničení 32.3750 (vzdálenost v km od ústí daného 

toku do jiného toku, nebo vodní plochy) po 38.0760. Na této ose toku je nutné přiřadit 

atributový název úseku Reach (zde: pod VD) a název toku River (zde: Třebůvka), dále 

atribut staničení daného toku FromStation (výše zmíněných: 32.3750 ), ToStation (výše 

zmíněných: 38.0760). 

Dalším krokem, který není povinný, jelikož jej lze definovat přímo v programu HEC-

RAS, je zakreslení břehových čar, což jsou linie tvořící hranici mezi korytem toku a 

inundačním územím. Pro jejich tvorbu byl vybrán nástroj: Ras Geometry → Create 

RAS Layers → Bank Lines a taktéž do dialogového okna byl zadán název vrstvy (zde: 

Banks). K zakreslení těchto břehů byla v editačním režimu obdobně jako u osy toku 

použita jako podklad k digitalizaci ortofotomapa CENIA připojená pomocí WMS služby. 

Břehovou linii nelze stanovit z těchto podkladů přesně, lze ji pouze odhadnout, dodatečná 

korekce (posun břehové linie) byla provedena v programu HEC-RAS.  

Dále je nutné nadefinovat hranice protékaných oblastí, mezi tyto oblasti se řadí koryto 

daného toku a inundační území, což je odhadnuté zátopové území, které bude 

pravděpodobně zasaženo záplavovou vlnou při destrukci VD Moravská Třebová. Pro 

vytvoření vrstvy  byl zvolen nástroj: Ras Geometry → Create RAS Layers → Flow 

Path Centerlines a tak jako u předešlých vrstev byl zadán název (zde: Flowpaths). 

Pokud je již zakreslena osa toku je možné ji nakopírovat jako jednu z os protékaných 

oblastí (koryto toku). Zde tedy byla použita již vytvořená vrstva River. Dále je nutné 

zakreslit v editačním režimu protékané oblasti na levém a pravém břehu, přičemž je nutné 

je zaklesovat ve směru toku řeky Třebůvky. Levá a pravá protékaná oblast byla 

zakreslena podle hranice záplavového území 100-leté povodně z databáze DIBAVOD 

rozšířené ještě o 2-160 metrů dle členitosti terénu a predikce možného zaplaveného 

http://geoportal.gov.cz/ArcGIS/services/CENIA/cenia_rt_ortofotomapa_aktualni/mapserver/WMSServer
http://geoportal.gov.cz/ArcGIS/services/CENIA/cenia_rt_ortofotomapa_aktualni/mapserver/WMSServer
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území. Tyto tři linie definují geometrické vlastnosti toku a je nutné jim přiřadit atribut o 

tom, zda se jedná o protékanou oblast v toku (Channel), na levém (Left), či pravém 

(Right) břehu.  

Nezbytnou vrstvou v přípravě dat vstupujících do HEC-RAS jsou příčné profily 

daného toku, které jsou vytvořeny v prostředí nástroje: Ras Geometry → Create RAS 

Layers → XS Cut Lines s názvem vrstvy XSCutLines. Tyto linie se dají vytvořit ručně, 

nebo podle nastavených parametrů vzájemné konstantní vzdálenosti jednotlivých profilů 

a jejich šířky. V  případě této bakalářské práce byly linie profilů vytvořeny ručně 

v editačním režimu, přesně ve staničení odpovídajícím příčným profilům získaným do 

Povodí Moravy, s.p. Ve zvoleném území na řece Třebůvce o délce toku necelých 6 km se 

nachází 67 těchto příčných řezů, jež definují koryto daného toku. Při vymezování linií 

příčných profilů bylo nutné dodržet několik pravidel: 

 Příčné profily musí být zakresleny z levého břehu na pravý (zleva doprava po 

směru toku řeky) 

 Příčné profily musí protínat všechny tři osy protékaných oblastí 

 Příčné profily se nesmí vzájemně protínat (mohou být zalomeny) 

 Příčné profily musí byt kolmé ke směru proudění (kolmé k ose daného toku) 

Díky těmto pravidlům (kolmosti k ose daného toku) a při dodržení staničení daného 

profilu bylo možné později v programu HEC-RAS zpřesnit koryto řeky Třebůvky 

získanými geodeticky naměřenými příčnými profily. 

Po vytvoření výše uvedených vrstev (viz Obr. 5, 6) je nutné je převést do 3D 

zobrazení, kdy jsou z dříve vytvořeného DSM ve formě gridu extrahovány výškové 

poměry a z vrstev Stream Centerline, XS Cut Lines pomocí Ras Geometry → Stream 

Centerlines Attributes → All, respektive Ras Geometry → XS Cut Line Attributes 

→ All   jsou vytvořeny vrstvy Stream Centerline 3D, XS Cut Lines 3D, ve kterých je 

každý bod přesně definován polohou v trojrozměrném prostoru.  

Obr. 5, 6: Vrstvy potřebné k vytvoření RAS GIS Import File na podkladu ortofotomapy CENIA 

(Zdroj: http://geoportal.gov.cz/arcgis/services) 

http://geoportal.gov.cz/arcgis/services
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Posledním krokem bylo vytvoření souboru s příponou *.RASimport.sdf pomocí 

nástroje Ras Geometry → Export RAS data, který má definovanou celou geometrii 

zvoleného toku a slouží pro import vytvořených dat do programu HEC-RAS. 

 

6.2 Modelování v HEC-RAS 

Po přípravě exportního souboru s koncovkou *.RASimport.sdf, který obsahuje vrstvy 

Stream Centerline 3D a XS Cut Lines 3D se práce v samotném modelačním programu 

HEC-RAS dá shrnout do několika kroků: 

 Založení projektu v programu HEC-RAS 

 Import dat vytvořených v softwaru ArcGIS (Hec-GeoRAS) 

 Editace geometrických dat, popř. přidání dalších charakteristik daného toku 

(stavby na toku, informace o drsnosti koryta a inundačních oblastí) 

 Zadání hydrologických dat 

 Analýza a prezentace výsledků 

Založení nového projektu 

Ještě před založením nového projektu a jeho uložením je nezbytné změnit 

v ovládacích panelech OS Windows v sekci: Místní a jazykové nastavení oddělování 

desetinných míst číslic z čárky na tečku. Tak, jako všechny programy mají své výstupní 

soubory, HEC-RAS má projekty, které mají po uložení příponu *.prj. Další nezbytností je 

změna jednotkového systému z původního používaného v USA (US Customary) na 

systém metrický (System International, Metric System) volbou v uživatelském rozhraní: 

Options → Unit system  (US Customary/SI). 

Import dat 

Do programu HEC-RAS je možné importovat data v různých formátech z CAD, GIS 

a dalších programů zabývajících se hydrologickým modelováním. Lze importovat celou 

geometrii toku, nebo jen geometrii příčných profilů. Z tohoto hlediska je HEC-RAS 

široce kompatibilní s ostatními softwary. Import vytvořených dat pomocí extenze HEC-

GeoRAS (geometrie řeky Třebůvky s příčnými profily) probíhal pomocí: Edit/Enter 

geometric data, v této sekci File → Import Geometry Data → GIS Format … a dále 

jen najít vyexportovaný soubor z ArcGIS 10. Pro další editaci této geometrie je nutné ji 

uložit. Importovaná geometrie zvolené řeky Třebůvky ohraničené staničením 32.3750 až 

38.0770 v prostředí HEC-RAS je na Obr. 7. 

Editace geometrických dat 

Všech 67 příčných profilů bylo upraveno podle geodeticky zaměřených příčných 

profilů koryta řeky Třebůvky. Dále byly doplněny mosty, kterých se nachází na tomto 

vodním toku 11. Geodeticky zaměřená data příčných profilů i s mosty byla získána od 

Povodí Moravy, s.p. a bližší specifikace těchto dat je uvedena v kapitole 4.2. 
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Obr. 7: Ukázka importované geometrie říčního toku v programu HEC-RAS 

Editace příčných profilů 

Přes okno Geometric Data je nutné spustit ikonou Cross Section editační rozhraní 

jednotlivých příčných profilů. Tyto příčné profily je možné měnit jak tabelárním 

způsobem (viz Obr. 8), tak grafickým. Editace tabelárním způsobem spočívá v zadání 

vzdálenosti od počátku daného profilu a nadmořské výšky v tomto bodě.  

V této bakalářské práci bylo tabelárním způsobem upraveno koryto řeky Třebůvky na 

všech 67 příčných profilech dříve vytvořených v programu ArcGIS, extenzi HEC-

GeoRAS. Tato úprava probíhala z důvodu zachycení přesného průběhu koryta podle 

jednotlivých geodeticky zaměřených příčných profilů. Tato editace byla nezbytná 

pro získání přesnějších a věrohodnějších výsledků po následujícím zadání 

hydrologických dat. Na Obr. 9 je zobrazen příčný profil 33.9850 před editací geometrie a 

na Obr. 10 po této editaci. 

 

 

 

 

 

 

 

 

 

 

 

 Obr. 8: Editace příčných profilů pomocí tabulkové metody  
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Obr. 9: Příčný profil staničení 33.9850 před editací geometrie 

 

 

 

 

 

Obr. 10: Příčný profil staničení 33.9850 po editaci geometrie 

Po této úpravě všech příčných profilů je ještě nutné zadat jednotlivým profilům 

tzv. součinitel drsnosti n (Manning’s n Value) pro koryto, pravý i levý břeh, který se dá 

vypočítat vzorcem odporu v otevřených korytech (převzato: HEC-RAS v 4.1 Reference 

Manual, 2010): 

       

 

 

kde v je střední průřezová rychlost [m/s], R je hydraulický poloměr [m] a I je 

sklon čáry energie [-]. Jednodušším řešením, které bylo použito i v rámci zpracování 

bakalářské práce, je nalézt si v HEC-RAS v4.1 Reference Manual tabulku odporů pro 

dané druhy koryt, záplavových území i různých druhů materiálů. Obecně se hodnoty pro 

hlavní koryto se pohybují od 0.025 až po 0.150 a pro okolní záplavové území od 0.025 po 

0.200. Všechny hodnoty Manning’s n Value jsou k nalezení ve výše zmíněném manuálu 

k softwaru HEC-RAS. Po konzultaci se zástupci státního podniku Povodí Moravy byly 

jednotlivým příčným profilům v oblasti koryta řeky Třebůvky přiřazeny hodnoty 

součinitele drsnosti v rozmezí od 0.032 po 0.050, což odpovídá korytu rovinného toku, 

kde nižší hodnoty znázorňují koryto bez peřejí, kamenů, nebo porostu, či plevele na dně. 

S narůstající hodnotou součinitele drsnosti těchto jevů v daném korytu narůstá. Pro 

2

1

3

2
1

IR
v

n 
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inundační území byly zvoleny hodnoty: 0.035, 0.060, 0.070, 0.100 a 0.200, kde hodnota 

0.035 odpovídá hladkému povrchu (asfalt, beton, holá půda), 0.060 zástavbě s částečným 

výskytem hladkého povrchu, 0.070 městské či vesnické zástavbě, 0.100 obdělávané půdě 

s výskytem travního porostu, či jednotlivých keřů a stromů a 0.200 hustému porostu trav, 

keřů a stromů. Hodnoty, které byly použity při řešení bakalářské práce, jsou uvedeny 

v Příloze 2.   

Editace mostů 

Pro editaci mostů je nutné ikonou Brdg/Culv otevřít dialogové okno pro zvolení 

objektu, který chceme vložit, a dále v Options → Add a Bridge and/or Culvert … je 

nutné zadat staničení daného mostu. Následně lze vytvořený most na daném staničení 

editovat pomocí  výběru nástroje Deck/Roadway (Obr. 11). U všech mostů vyskytujících 

se ve vymezeném území byla doplňována vzdálenost od předešlého příčného profilu, 

šířka mostu, horní a spodní hrana daného mostu. Horní a spodní hrana byla definována 

jak pro začátek, tak i pro konec mostu (upstream, downstream). Dalším atributem, který 

je nutné zadat je hodnota součinitele přepadu (Weir Coef). Přepad vzniká postavením 

překážky po směru proudění daného toku (typickým příkladem přepadu jsou jezy). Na 

vymezeném úseku se žádné jezy nenachází, proto byla u všech mostů ponechána původní 

hodnota používaná softwarem HEC-RAS, a to součinitel přepadu (1.4).   Zadané hodnoty 

11 mostů vyskytujících se na řece Třebůvce jsou zobrazeny v Tab. 12. Data o 

jednotlivých mostech byla získána stejně jako příčné profily od Povodí Moravy, s.p. 

 

 

 

 

 

 

 

 

 

 

 

 

Obr. 11: Editace parametrů mostů 
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Tab. 12: Zadané hodnoty mostů   

Staničení 
[km] 

Vzdálenost 
(Distance) 

[m] 

Šířka 
(Width) 

[m] 

Upstream Downstream 

Horní hrana 
[m n. m.] 

Spodní hrana 
[m n. m.] 

Horní hrana 
[m n. m.] 

Spodní hrana 
[m n. m.] 

32.9630 53 13 337.01 334.58 337.01 334.58 

34.1390 22 4 337.38 336.00 337.38 336.00 

34.5820 25 6 337.91 336.22 337.91 336.22 

35.6000 23 14 352.60 347.31 352.60 347.31 

35.6330 55 10 347.46 342.45 347.46 342.45 

36.1320 10 6 346.49 344.50 346.49 344.50 

36.2650 14 8 347.35 344.90 347.35 344.90 

36.7570 91 13 355.75 352.68 355.75 352.68 

36.8660 48 13 358.18 355.05 358.18 355.05 

37.0480 40 8 350.97 349.75 350.97 349.75 

37.9810 95 15 357.96 357.02 357.96 357.02 

 

Zadání dat ustáleného proudění 

Pro modelování povodňové vlny, což je neustálené proudění, je nutné vytvořenou 

geometrii toku „naplnit“ daty ustáleného proudění, nad kterými bude probíhat výpočet 

neustáleného proudění. Ustálené proudění se zadává v uživatelském prostředí volbou 

Edit → Steady Flow Data. Zde je možné zadat do kolonky Edit/Enter Number of 

Profiles hodnotu pro kolik různých průtoků se má provést výpočet ustáleného proudění. 

Podle zadaného počtu je tedy potřeba tolikrát vyplnit hodnotu průtoku v m
3
/s a navolit 

jeho horní a dolní okrajové podmínky. V HEC-RAS je možné oba druhy okrajových 

podmínek volit čtyřmi způsoby: 

 Known W.S. (při zadaném průtoku známe výšku této hladiny v daném 

příčném profilu).  

 Critical Depth (kritická hloubka v dolním profilu). 

 Normal Depth (musíme znát sklon hladiny za předpokladu rovnoměrného 

proudění, na základě které bude vypočtena měrná křivka profilu).  

 Rating Curve (zadávání známé závislosti výšky hladiny na měrné křivce).  

 

V případě této bakalářské je postačující zadat pouze jeden průtok, konkrétně průtok 

vyskytující se při povodni v průměru jednou za 5 let (Q5), který činí 11 m
3
/s, z důvodu 

pouze naplnění geometrie hydrologickými daty, nad kterými bude probíhat výpočet 

neustáleného proudění. Po zadání těchto dvou parametrů je nutné navolit okrajové 

podmínky. Jako horní okrajová podmínka byla zvolena možnost Known W.S., tzn. při 

průtoku Q5=11 m
3
/s je na prvním profilu pod VD Moravská Třebová se staničením 

38.0760 výška hladiny 354,54 m n. m.  Dolní okrajovou podmínkou byla zvolena 

možnost Normal Depth, kdy byl vypočten sklon hladiny na základě známé výšky 

hladiny, a to výšky 354,54 m n. m. na prvním profilu se staničením 38.0760 při průtoku 

Q5 a výšky 333,23 m n. m. na posledním příčném profilu se staničením 32.4540 při 
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stejném průtoku. Vzdálenost těchto dvou profilů je 5,622 km. Z těchto parametrů po 

dosazení do vzorce 

 

 

 

 

vyjde sklon hladiny 0,003790, ze které si následně software HEC-RAS vypočte měrnou 

křivku profilu. Tyto okrajové podmínky byly zvoleny z hlediska nejjednoduššího zadání 

a výpočtu vstupních parametrů.   

Zadání neustáleného proudění 

Parametry neustáleného proudění se zadávají v uživatelském prostředí volbou Edit → 

Unsteady Flow Data. Zadání neustáleného proudění probíhá stejně jako ustálené pomocí 

okrajových podmínek. Na prvním příčném profilu pomocí hydrografu, což je časová řada 

průtoku (Flow Hydrograph), výšek hladin (Stage Hydrograph), nebo obou veličin 

(Stage/Flow Hydr.). Této časové řadě se musí zadat interval (sekundy, minuty, hodiny), 

popř. přesné datum startu dané časové řady a k jednotlivým časům přiřadit danou 

hodnotu průtoku, resp. výšku hladiny (Obr. 12). Díky přesnému zadání data může 

simulace probíhat v reálném čase. Dolní okrajové podmínky lze zadat taktéž pomocí 

hydrografů, nebo výše zmíněných okrajových podmínek zmíněných při ustáleném 

proudění (Normal Depth, Ratig Curve).  

V této práci byla jako horní okrajová podmínka zvolena možnost Flow Hydrograph 

(časová řada průtoků) na prvním příčném profilu se staničením 38.0760. Časová řada 

průtoků, což je predikovaná časová řada průtoků při postupné úplné destrukci hráze VD 

Moravská Třebová, byla získána od státního podniku Povodí Moravy, a proto byla také 

po konzultaci se zástupci výše zmíněného státního podniku zvolena jako horní okrajová 

podmínka možnost Flow Hydrograph. Interval této časové řady byl stanoven na 3 min a 

počátek poruchy a následného rozpadání se hrazení byl stanoven na smyšlené datum 1. 

března 2012 v čase 8:00. Tato časová řada průtoků je ve formě tabulky součástí Přílohy 3.  

Dolní okrajovou podmínkou byla zvolena stejně jako u zadávání dat ustáleného proudění 

možnost Normal Depth s totožnou hodnotou sklonu hladiny.  

Analýza 

Program HEC-RAS umožňuje řešit proudění třemi různými způsoby, a to prouděním 

říčním (Subcritical), bystřinným (Supercritical) a smíšeným (Mixed). Třebůvka je sice 

řekou, ale při modelování povodňové vlny při destrukci VD Moravská Třebová bylo 

použito smíšeného proudění (Mixed), ve kterém se vlny na hladině při normálním 

průtoku mohou šířit i proti proudu. Výhodou programu HEC-RAS je, že před zahájením 

kteréhokoliv způsobu analýzy je možné spustit kontrolu správnosti dat, která v případě 

chyby v zadávaných datech vypíše list chybných zadání, což usnadní a urychlí následnou 

opravu. 

 

 tokuose body v mezi vzdálenost

bodů výšek rozdíl
i
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Obr. 12: Zadávání neustáleného odtoku pomocí časové řady průtoků 

 

6.3 Prezentace výsledků 

Výsledky lze prezentovat jak v grafické podobě ve formě jednotlivých příčných 

profilů, podélného profilu, či pohledu na celý řešený úsek (Obr. 13), tak v podobě 

tabelárních výstupů. HEC-RAS nabízí i aplikaci, která umožňuje jednotlivé grafické 

výsledky projíždět animacemi. Tento software nabízí mnoho možností prezentace daných 

výsledků, ale k dosažení přesnějších výsledků, tzn. vytvoření hranic rozlivu a výpočtu 

výšek hladin v daném území, je nutné data získaná z HEC-RAS vyhodnotit post-

processingem znovu v prostředí GIS, resp. v ArcGIS 10, extenzi HEC-GeoRAS 10.   

Obr. 13: Namodelovaná povodňová vlna v prostředí softwaru HEC-RAS 
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Post-processing v programu ArcGIS 10 (HEC-GeoRAS) 

Prvním krokem byla konverze výsledkového souboru s koncovkou *.sdf uloženého 

softwarem HEC-RAS do formátu *.XML pomocí ikony Import RAS SDF File na 

panelu nástrojů extenze HEC-GeoRAS. Dále je nutné volbou RAS Mapping → Layer 

Setup nastavit název nového datového rámce vytvořeného v prostředí ArcMap, cestu 

k dříve vytvořenému DSM ve formě gridu, cestu k xml souboru a adresář do kterého se 

budou ukládat pozdější úpravy. Po tomto nastavení vrstev se v novém datovém rámci 

objeví vrstvy River, XSCutLines, BoundingPolygon (vytvořená vrstva softwarem HEC-

RAS, která zobrazuje polygon maximálního rozlivu vypočítaného na jednotlivých 

profilech) a vrstvu DSM. Všechny tyto vrstvy jsou nezbytné k vytvoření rastrové plochy 

hladiny, která je nutná k vytvoření polygonu hranic rozlivu (ve vektorovém formátu), a 

k výpočtu hloubek (výšky vody) v zaplaveném území (v rastrovém formátu). 

Plocha hladiny byla vytvořena volbou: RAS Mapping → Inundantion Mapping → 

Water Surface Generation. Takto vznikne vrstva plochy hladiny ve formě TINu, ale 

jelikož je DSM grid musel být vytvořený TIN převeden opět na raster o velikosti pixlu 

stejném jako u DSM (1×1 m) pomocí funkce 3D Analyst Tools → Conversion → From 

TIN → TIN to Raster. Poté byla vytvořena výše zmíněná vrstva rozlivu a hloubky 

pomocí: RAS Mapping → Inundantion Mapping → Floodplain Delineation Using 

Rastem. Takto vznikly dvě nové vrstvy. Vrstva obsahující vektorová data s polygony 

ohraničujícími záplavové území a rastrová vrstva s hodnotami hloubek vody v 

záplavovém území. 
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7 VÝSLEDKY 

Hlavním výsledkem bakalářské práce je namodelovaná povodňová vlna způsobená 

postupnou úplnou destrukcí vodního díla Moravská Třebová, která je znázorněna jak 

pomocí mapových výstupů, tak pomocí parametrů uvedených v grafech a tabulkách. 

V této kapitole jsou shrnuty parametry této povodňové vlny a hodnocení zaplaveného 

území s navazujícími informacemi z oblasti ochrany obyvatelstva. 

7.1 Parametry povodňové vlny 

Při modelování povodňové vlny s postupným a úplným protržením hrazení 

s počátkem sufoze ve výšce 357,20 m n. m. byl stanoven počátek poruchy na smyšlené 

datum 1. 3. 2012 v čase 8:00 (viz kap. 6.2). Po zadání tohoto data vychází (z dat 

predikovaných průtoků poskytnutých Povodím Moravy s. p.) protržení hrazení vodního 

díla Moravská Třebová na 9:30, tedy 1 h a 30 min po začátku poruchy. Kulminační 

průtok při této poruše je u spodní výpusti tohoto VD 141 m
3
s

-1
.  

Na profilech se staničením 37.5290, 36.3990, 35.6230 a 32.9380 (Obr. 14) je ukázán 

průběh namodelované povodňové vlny (kulminace, čas kulminace, doba zpoždění a 

hydrogram těchto příčných profilů). Tyto profily byly vybrány po konzultaci se zástupci 

Povodí Moravy s. p. na základě jejich polohy: 37.5290 (profil pod čerpací stanicí 

pohonných hmot v Moravské Třebové), 36.3990 (profil nad silničním mostem 

v Moravské Třebové), 35.6230 (profil nad křížením obchvatu pod Moravskou Třebovou) 

a 32.9380 (profil nad silničním mostem v Linharticích) a zvoleny jako dostatečně 

charakterizující tuto zvláštní povodeň.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Obr. 14: Lokace profilů se staničením 37.5290, 36.3990, 35.6230 a 32.9380 
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V Příloze 4 jsou zobrazeny tyto čtyři profily s časovou řadou vypočítaných průtoků 

programem HEC-RAS s krokem 5 min. Z této přílohy lze vyjádřit kulminaci, čas této 

kulminace, od začátku poruchy, resp. protržení hráze VD Moravská Třebová: 

 Profil se staničením 37.5290: 

o Kulminace: 105,801 m
3
s

-1
 

o Čas kulminace: 9:55 

o Od začátku poruchy (8:00): 1 h 55 min 

o Od protržení hráze (9:30): 25 min  

 Profil se staničením 36.3990: 

o Kulminace: 86,309 m
3
s

-1
 

o Čas kulminace: 10:35 

o Od začátku poruchy (8:00): 2 h 35 min 

o Od protržení hráze (9:30): 1 h 5 min  

 Profil se staničením 35.6230: 

o Kulminace: 85,45 m
3
s

-1
 

o Čas kulminace: 10:55 

o Od začátku poruchy (8:00): 2 h 55 min 

o Od protržení hráze (9:30): 1 h 25 min  

 Profil se staničením 32.9380: 

o Kulminace: 75,484 m
3
s

-1
 

o Čas kulminace: 11:50 

o Od začátku poruchy (8:00): 3 h 50 min 

o Od protržení hráze (9:30): 2 h 20 min  

 

K těmto výše zmíněným profilům byly vytvořeny i hydrogramy: 

 Profil se staničením 37.5290 (Obr. 15): 

 

 

 

 

 

 

 

Obr. 15: Hydrograf profilu se staničením 37.5290  
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 Profil se staničením 36.3990 (Obr. 16): 

 

 

 

 

 

 

 

Obr. 16: Hydrograf profilu se staničením 36.3990  

 Profil se staničením 35.6230 (Obr. 17): 

 

 

 

 

 

 

 

Obr. 17: Hydrograf profilu se staničením 35.6230  

 Profil se staničením 32.9380 (Obr. 18): 

 

 

 

 

 

 

 

Obr. 18: Hydrograf profilu se staničením 32.9380  

Časový průběh zvláštní povodně ZPV na profilu 

se staničením km 36.3990  

30

40

50

60

70

80

90

100

110

8:
00

:0
0

8:
10

:0
0

8:
20

:0
0

8:
30

:0
0

8:
40

:0
0

8:
50

:0
0

9:
00

:0
0

9:
10

:0
0

9:
20

:0
0

9:
30

:0
0

9:
40

:0
0

9:
50

:0
0

10
:0

0:0
0

10
:1

0:0
0

10
:2

0:0
0

10
:3

0:0
0

10
:4

0:0
0

10
:5

0:0
0

11
:0

0:0
0

11
:1

0:0
0

11
:2

0:0
0

11
:3

0:0
0

11
:4

0:0
0

11
:5

0:0
0

12
:0

0:0
0

12
:1

0:0
0

12
:2

0:0
0

čas

p
rů

to
k

 m
3

/s

Časový průběh zvláštní povodně ZPV na profilu 

se staničením km 35.6230  
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 Přehled časového průběhu ZPV na čtyřech vybraných profilech (Obr. 19): 

  Obr. 19: Hydrograf výše zmíněných  

Z tabulek časové řady průtoků a hydrogramů jednotlivých příčných profilů lze 

vytvořit mapy zpoždění kulminačních průtoků od počátku poruchy (Obr. 20) VD 

Moravská Třebová, které je stanoveno na 1. 3. 2012, 8:00, nebo zpoždění těchto 

kulminačních průtoků od protržení hrazení (Obr. 21) tohoto vodního díla, které je 

stanoveno na 9:30.    

 

Obr. 20: Časové zpoždění kulminačního průtoku v minutách od začátku poruchy VD Moravská 

Třebová 
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Obr. 21: Časové zpoždění kulminačního průtoku v minutách od protržení VD Moravská Třebová 

Z jednotlivých grafů průběhu a map časového zpoždění kulminačních průtoků je 

vidět, že se vzrůstající vzdáleností od VD Moravská Třebová se snižuje kulminační 

průtok. Dále tento průtok nastává později s nárůstem této vzdálenosti a také pomaleji se 

tato voda vylitá z břehů vrací zpět do koryta řeky, např.: na profilu se staničením 

37.5290, který se nachází pod čerpací stanicí v Moravské Třebové, dochází ke kulminaci 

v 9:55, tj. 1h a 55 min po zjištění poruchy na daném VD, kde před poruchou se průtok 

pohyboval na tomto profilu kolem hodnoty 47 m
3
s

-1
 a zpět k těmto hodnotám se vrátil 

kolem 11:45, tj. necelé dvě hodiny od kulminačního průtoku. Z toho vyplývá, že opadnutí 

zvláštní povodně dále od vodního díla, např.: v Linharticích, či dalších obcích 

nacházejících se na vodním toku Třebůvka, může trvat i několik desítek hodin, ale 

kulminační průtok už nebude mít takovou rychlost, tudíž dopad na tyto obce bude menší 

nežli obce blízké vodnímu dílu. 

Jak již bylo popsáno v kap. 6.3, byl také vytvořen ke znázornění této povodňové vlny 

polygon znázorňující záplavové území (Obr. 22) při kulminačním průtoku na 

jednotlivých profilech (tzn. maximální možné zaplavené území) a také rastrová data s 

hodnotami hloubek vody v záplavovém území (Obr. 23). Pomocí těchto dvou vrstev 

probíhalo následné hodnocení zaplavených obcí Moravská Třebová a Linhartice. 
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Obr. 22: Záplavové území ZPV způsobené destrukcí VD Moravská Třebová 

 

 Obr. 23: Výška hladiny nad povrchem při kulminaci po destrukcí VD Moravská Třebová 
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7.2 Hodnocení zaplavené oblasti 

Při zvláštní povodni způsobené destrukcí vodního díla Moravská Třebová bude 

zaplaveno v katastrálním území Moravská Třebová a Linhartice asi 1,062 km
2
 (106,20 

ha)
 
plochy. Zastoupení jednotlivých druhů využití půdy v katastrálním území Moravská 

Třebová a Linhartice při zvláštní povodni způsobené destrukcí vodního díla dle rozlohy 

v zaplaveném území (analýza probíhala nad daty ZABAGED®): 

 Trvalý travní porost.…………………………………….42,22 ha 

 Zahrady………………………………………………….24,03 ha 

 Orná půda……………………………………………….15,62 ha 

 Ostatní plocha v sídlech…………………………………10,79 ha 

 Průmyslové areály………………………………………..3,72 ha 

 Okrasné zahrady a parky…………………………………2,00 ha 

 Ostatní plocha (vodní plocha, skládky, hřiště…)………...7,82 ha  

Vymezené záplavové území při destrukci vodní nádrže Moravská Třebová 

s jednotlivými druhy využití půdy v katastrálním území Moravská Třebová a Linhartice 

je zobrazeno v Příloze 5. 

  

7.2.1 Objekty v záplavovém území 

V katastrálním území Moravská Třebová leží v záplavové oblasti zvláštní povodně 

způsobené destrukcí vodního díla 95 budov (bloků budov) z celkového počtu asi 2000 

budov či bloků budov, což není ani 5 % těchto objektů. V katastrálním území Linhartice 

je tento podíl mnohem větší. Zde leží v záplavové oblasti z celkového počtu 244 budov 

(bloků budov) celých 119 těchto objektů. Podíl těchto objektů v záplavovém území je 

necelých 49 %. Z celkového počtu zaplavených objektů je 14 průmyslových. Všechny 

tyto průmyslové objekty se nacházejí na pomezí obou katastrálních území, kde se 

rozkládá centrum lehké a střední průmyslové výroby.  

Ve městě Moravská Třebová se v záplavovém území nachází ulice Anenské údolí, 

Brněnská, Dvorní, Gorazdova, Horní, Jateční, Jevíčská, Mlýnská, Nové Sady, 

Olomoucká, Piaristická, Rybní a Vodní, což jsou dohromady ulice o délce 2,62 km. 

V Tab. 13 jsou uvedeny všechny zaplavené ulice v Moravské Třebové s celkovou délkou 

ulice a délkami těchto ulic v jednotlivých výškách hladin. 

Na těchto ulicích se z významných objektů nachází pouze obchodní dům Lidl, a to 

v blízkosti hráze vodního díla, na ulici Brněnská, který bude zaplaven i s přilehlým 

parkovištěm, na kterém se nejvyšší dosažená výška bude pohybovat kolem 2 m. Dále 

bude zaplaveno víceúčelové sportovní hřiště na ulici Jevíčská. 
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Tab. 13: Délky ulic k jednotlivým výškám hladin v Moravské Třebové 

Ulice 
Délka v 

zaplaveném území 
[m] 

Délka ulic [m] v jednotlivých výškách hladin [m] 

0,5 a 
méně 

0,5-1 1-1,5 1,5-2 2-2,5 

Anenské údolí 67,8 67,8 0 0 0 0 

Brněnská 474,5 96 50,5 103 225 0 

Dvorní 257,6 8,1 159 22,8 62,4 4,7 

Gorazdova 140,6 22 38,6 21,9 35,1 23 

Horní 178,6 38 23,1 12,5 105 0 

Jateční 269,6 0 0 109,6 160 0 

Jevíčská 138,5 46,1 73 7,7 11,7 0 

Mlýnská 101,3 10,2 27,3 17,4 46,4 0 

Nové Sady 56,8 38,7 18,1 0 0 0 

Olomoucká 392,1 73,7 41,2 21,6 112,3 143,3 

Piaristická 259,3 56,6 48,9 22,3 67,5 64 

Rybní 90,4 0 28,4 14,9 47,1 0 

Vodní 187,6 34,3 27,1 27,5 74,1 24,6 

 

 V obci Linhartice nemají ulice názvy, ale v záplavovém území se nalézá 6,14 km 

těchto ulic. V procentuálním zastoupení k jednotlivým kulminačním výškám: 2 % (2,5 m 

a více), 21,1 % (2-2,5 m), 19 % (1,5-2 m), 9 % (1-1,5 m), 29,8 % (0,5-1 m) a 20,1 % (0-

0,5 m). V záplavovém území se na adrese Linhartice 116 nachází i základní a mateřská 

škola, což je velmi významný objekt z hlediska případné evakuace obyvatelstva, u 

kterého bude nejvyšší dosažená výška hladiny 1,5 m. Stejně jako ve městě Moravská 

Třebová se také v zaplavené oblasti nachází sportovní fotbalové hřiště.  

V této bakalářské práci jsou odlišeny ulice a komunikace z důvodu lepší přehlednosti 

komunikační sítě, a také z důvodu, že na některých důležitých ulicích v hodnocených 

obcích Moravská Třebová a Linhartice se nenachází silniční síť.   

 

Ohrožující objekty v záplavovém území 

Na katastrálním území Moravská Třebová se nachází několik těchto objektů. Na 

adrese Jateční 1522/7 se nachází skládka odpadů. Na stejné ulici se nachází i rozvodna 

elektrické energie. Oba objekty budou při kulminační vlně zaplaveny do výšky 1 až 2 m. 

Mezi nejdůležitější ohrožující objekty (viz Kap. 3.3) patří čerpací stanice. V Moravské 

Třebové se v blízkosti hráze stejnojmenného vodního díla nalézají hned tři čerpací stanice 

pohonných hmot nebo zkapalněného ropného plynu, z toho dvě přímo v záplavové zóně 

zvláštní povodně. Podrobné informace o těchto ohrožujících objektech v podobě 

čerpacích stanic jsou zobrazeny v Tab. 14. 

V katastrálním území Linhartice se nachází v záplavovém území, na adrese Linhartice 

106, také čistírna odpadních vod se dvěma usazovacími nádržemi, na které bude 

kulminační hladina dosahovat výšky 1,5-2 m. 
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Tab. 14: Ohrožující objekty s možností technologické havárie – požár, exploze, destrukce (zdroj: 

HZS Pardubického kraje) doplněné o informaci udávající výšku kulminační hladiny (zdroj: autor) 

 

7.2.2 Komunikace 

Komunikace jsou velmi důležitou složkou dopravní infrastruktury. Zaplaveným 

územím neprochází žádná dálnice či rychlostní komunikace. Nejvýznamnější tah, který 

bude v obci Moravská Třebová částečně neprůjezdný, je silnice 1. třídy číslo 35. Tato 

silnice vede z hraničního přechodu Hrádek nad Nisou přes Liberec, Turnov, Jičín, 

Litomyšl, Moravskou Třebovou, Mohelnici, Olomouc, Valašské Meziříčí až po Makov, 

hraniční přechod se Slovenskou republikou. Délka této komunikace je 333,1 km, z čehož 

je 52,6 km rychlostních. Na území Moravské Třebové je zaplavením ohroženo 1169,21 m 

této komunikace 1. 

Ze silnic 2. třídy budou zaplaveny silnice číslo 368 a 371 a z komunikací 3. třídy 

silnice číslo 3711 a 38625. Dále bude neprůjezdný kruhový objezd spojující silnici 1. 

třídy číslo 35 a silnici 2. třídy číslo 368, kde výška kulminační vlny bude dosahovat 1,5 

m, další výšky kulminační vlny k délce jednotlivých komunikací jsou uvedeny v Tab. 15. 

V záplavovém území bude se také nalézat mnoho udržovaných i neudržovaných cest 

místního významu. Délky jednotlivých komunikací dle třídy silnice ohrožené zaplavením 

spolu s intenzitou dopravy na těchto tazích (vycházející z celostátního sčítání dopravy 

ŘSD - Ředitelství silnic a dálnic ČR z roku 2010) jsou uvedeny v Tab. 16. 

Tab. 15: Délka zaplavených silnic k výškám kulminačních hladin 

Třída 
silnice 

Číslo 
silnice 

Délka silnice [m] v jednotlivých výškách hladin [m] 

0,5 a 
méně 

0,5-1 1-1,5 1,5-2 2-2,5 

1. 35 224.8 348,9 98,3 414,2 83 

2. 371 57 39 93,3 137,6 63,1 

2. 368 70.39 52,3 64 164,7 0 

3. 3711 630 614,3 415 359,5 580,5 

3. 36825 25,2 50,9 0 0 0 

 

Objekt Obec Ulice Č.p. Ohrožující faktor Množství 

Výška 

kulminační 

hladiny [m] 

Čerpací stanice 

OMV ČR s.r.o. 

Moravská 

Třebová 
Dvorní 20 PHM (pohonné hmoty) 100 t 1,5-2 

Čerpací stanice  

ORALL 

Moravská 

Třebová 
Dvorní 13 PHM (pohonné hmoty) 23 t 0-0,5 

Čerpací stanice  

ORALL 

Moravská 

Třebová 
Dvorní 13 

LPG 

(zkapalněný ropný plyn) 
2,5 t 0-0,5 

http://cs.wikipedia.org/wiki/Ropa
http://cs.wikipedia.org/wiki/Plyn
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Tab. 16: Délky silnic v území ohrožené zaplavením dle třídy a intenzity dopravy (zdroj údajů o 

intenzitě dopravy: Sčítání dopravy 2010 dostupné z: 

http://scitani2010.rsd.cz/pages/informations/default.aspx) 

 

Intenzita dopravy je důležitá z hlediska krizového řízení, kdy na základě této intenzity 

budou plánované objízdné trasy pro jednotlivé komunikace.  

Katastrálním územím Moravská Třebová a Linhartice prochází jedna jednokolejová 

železniční trať s číselným označením 262 spojující Mladějov na Moravě a Chornici, ze 

které bude zaplaveno necelých 569 m (300 m v obci Linhartice a 269 ve městě Moravská 

Třebová) této tratě. Tato trať bude neprůjezdná, protože výška hladiny při kulminaci bude 

dosahovat až 2 m na některých částech této železniční komunikace. 

7.2.3 Ochrana obyvatelstva 

Varování obyvatelstva 

Varování obyvatelstva bude probíhat dle postupů a prostředků uvedených v Kap. 3.1. 

Konfliktem v této oblasti je fakt, že se místo obsluhy obecního rozhlasu pro obec 

Linhartice, čímž je obecní úřad, nachází v záplavové oblasti, kde při kulminačním 

průtoku bude výška vody dosahovat až 1,5 m.   

Evakuace obyvatelstva 

Evakuace obyvatelstva patří k hlavním preventivním opatřením při hrozící popř. 

probíhající zvláštní povodni. Po konzultaci se zástupci Hasičského záchranného sboru a 

po analýze rozsahu zvláštní povodně se došlo k závěru, že při protržení vodního díla 

Moravská Třebová je nutné evakuovat z města Moravská Třebová přibližně 50 osob 

z celkového počtu asi 11 000 obyvatel a přibližně 60 osob žijících v Linharticích 

z celkového počtu 633 osob. Tyto osoby jsou evakuovány převážně z rodinných domů 

nacházejících se v blízkosti vodního toku Třebůvka. Data o počtu obyvatel nebylo možné 

získat na úrovni budov, nebo ulic (kolik obyvatel se vztahuje k číslu popisnému), protože 

tato data vede pouze Český statistický úřad a zákonem je svázán o jejich neposkytování. 

K těmto datům mají přístup pouze důležité složky státní správy. Z tohoto důvodu nelze 

tento počet obyvatel v bakalářské práci metodicky podložit, a proto je stanoven pouze 

celkově. Tento počet byl poskytnut HZS Pardubického kraje po konzultaci výsledných 

parametrů namodelované povodňové vlny způsobené postupnou úplnou destrukcí vodní 

nádrže Moravská Třebová.  

Třída silnice Číslo silnice Intenzita dopravy [vozů/24h] Délka zaplaveného úseku [m] 

1. 35 10208 1169,21 

2. 371 1464 389,95 

2. 368 6453 351,39 

3. 3711 2688 2599.25 

3. 36825 nehodnoceno 76.08 

http://scitani2010.rsd.cz/pages/informations/default.aspx
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Evakuované obyvatelstvo, které nevyužije vlastních prostředků dopravy a ubytování u 

příbuzných, či známých v nezaplavené oblasti, bude sváženo do evakuačního střediska 

v Moravské Třebové (viz Tab. 8) po evakuačních trasách silnic a místních komunikací, 

které se nenacházejí v záplavové oblasti.      

 

Výsledky bakalářské práce byly předloženy zástupcům HZS Olomouckého kraje a 

mohly by být zapracovány do povodňových plánů HZS a zobrazeny na jejich 

informačních systémech (mapových serverech). Dále by výsledky mohli sloužit ke 

krizovému řízení zasažených obcí Moravská Třebová a Linhartice, nebo mohou být 

zapracovány do krizového plánu kraje. Grafické výsledky mohou být využity státním 

podnikem Povodí Moravy, jelikož dosud nemají k této zvláštní povodni zpracované 

žádné mapové výstupy 
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8 DISKUZE 

Hlavním cílem bakalářské práce bylo namodelování povodňové vlny při destrukci 

vybrané vodní nádrže pomocí modelu HEC-HMS. Původní zadání softwaru pro 

zpracování bakalářské práce nebylo možné použít, protože tento model slouží pouze k 

modelování přímého povrchového odtoku, který se vytváří přepočtem srážkových dat. 

Pro zpracování bakalářské práce byl tedy použit vhodnější model HEC-RAS patřící mezi 

hydrodynamické modely. 

Jedinou nevýhodou softwaru HEC-RAS je nutnost poměrně velmi přesných vstupních 

dat. Jelikož byla geometrická data použita z výškopisných dat ZABAGED®, která jsou 

rozmístěná ve čtvercové síti s krokem 10 m, není možné přesně zachytit geometrické 

vlastnosti koryta řeky. Proto byla tato data doplněna geodeticky zaměřenými příčnými 

profily daného koryta. Na zvoleném úseku je jich státním podnikem Povodí Moravy 

zaměřeno 67 spolu s 11 dalšími mosty. Ideální by bylo těchto příčných profilů mít více, 

ale měření vlastních příčných profilů na řece Třebůvka bylo zamítnuto kvůli velké časové 

náročnosti a získání přesného DSM nebylo možné. 

 Software HEC-RAS disponuje mnohem širšími možnostmi výpočtů a nastavení než 

bylo využito při řešení této bakalářské práce. Např. možnost řešení stromových říčních 

sítí, která by mohla zpřesnit namodelovanou záplavovou vlnu hlavně v obci Linhartice, 

nad kterou ústí do řeky Třebůvky levostranný přítok (Kunčický potok), ale pro tento tok 

nejsou na Povodí Moravy, s.p. dostupné příčné profily a přesná hydrologická data, bez 

nichž nelze spustit výpočet. Dále má tento program také široký rozsah možností nastavení 

při umisťování staveb (mostů, jezů…) na daném toku, u kterých lze zadat přesné umístění 

a rozměry mostních pilířů, materiál ze kterého jsou vyrobeny a mnoho dalších parametrů. 

Při získání těchto dat by bylo možné zpřesnit výsledek modelování povodňové vlny 

způsobené destrukcí VD Moravská Třebová.  

 Při řešení bakalářské práce byla zadávána vždy jen horní okrajová podmínka (při 

ustáleném i neustáleném proudění), která byla získána od státního podniku povodí 

Moravy, ale dolní okrajová podmínka byla pouze vypočítána na základě známých 

parametrů. Při modelování neustáleného proudění by bylo ideální, kdyby horní i spodní 

okrajová podmínka byla časová řada průtoků, což by lépe vystihlo průběh modelované 

povodně. 

Výpočet výšky hladiny nad povrchem při kulminaci byl také stanoven z vytvořeného 

DSM z výškopisných dat ZABAGED® doplněných o výšky budov. Tato data, jak již 

bylo výše uvedeno, jsou zaměřena ve čtvercové sítí 10×10 m, čímž se naskytuje nejasnost 

průběhu skutečných výšek mezi zaměřenými body.  

K dílčím pracím také patřilo stanovení počtu obyvatel potřebných k evakuaci. Tato 

data nebylo možné získat na úrovni domů, či ulic, jelikož je vlastní pouze Český 

statistický úřad a zákonem je svázán o jejich neposkytování. K těmto datům mají přístup 

pouze důležité složky státní správy. 
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9 ZÁVĚR 

Cílem bakalářské práce bylo namodelování povodňové vlny při destrukci vybrané 

vodní nádrže a její zobrazení v mapě s  následným hodnocením zaplaveného území spolu 

s informacemi z oblasti ochrany obyvatelstva. K dílčím cílům patřilo získání a příprava 

dat, popř. informací potřebných pro naplnění hydrodynamického modelu HEC-RAS.  

V první, teoretické části se bakalářská práce zabývá ochranou obyvatelstva, 

extrémními hydrologickými jevy se zaměřením na zvláštní povodeň, hydrologickými 

modely s jejich rozdělením a možnostmi modelování ustáleného a neustáleného proudění 

v korytě. Ve druhé části, té praktické se práce věnuje přípravě dat pro modelování 

povodňové vlny při destrukci vybrané vodní nádrže, kterou byla po konzultaci se zástupci 

státního podniku Povodí Moravy a HZS Olomouckého a Pardubického kraje zvolena 

vodní nádrž Moravská Třebová a následně samotné modelaci v hydrodynamickém 

1D softwaru HEC-RAS. Tento software řeší geometrii toku metodou po úsecích a 

neustálené proudění v korytě pomocí Saint-Venantových rovnic. Po namodelování 

povodňové vlny se práce zabývá hodnocením zaplaveného území ve městě Moravská 

Třebová a obci Linhartice spolu s hodnocením z hlediska ochrany obyvatelstva ve 

zmíněném městě a obci.   

Hlavním výsledkem této práce je tedy namodelovaná povodňová vlna způsobená 

postupnou úplnou destrukcí vodního díla Moravská Třebová spolu s parametry 

(kulminace, hydrogramy…) charakterizující tuto povodňovou vlnu, které jsou poukázány 

na vybraných příčných profilech pomocí výše zmíněných hydrogramů, času kulminace 

od začátku poruchy a protržení VD Moravská Třebová a časové řadě průtoků. Na základě 

tohoto modelování vznikla vektorová vrstva ohraničující záplavové území a rastrová 

vrstva obsahující data s hodnotami hloubek vody v záplavovém území. 

 Dalším výsledkem je vyhodnocení zaplavené oblasti z hlediska využití půdy v daném 

území, uliční sítě spolu s hloubkami vody na jednotlivých ulicích ve městě Moravská 

Třebová a obci Linhartice a také byl na základě vrstvy záplavového území stanoven počet 

zaplavených budov, či bloků budov a průmyslových objektů. Dále byla hodnocena 

komunikační sítě, ze které bude ve vymezeném území zaplaveno více než 4,5 km silnic I. 

II. a III. třídy a více než 500 m železniční tratě číslo 262. K těmto silnicím a železnici 

byla také určená výška hladiny při kulminačním průtoku způsobeném úplnou destrukcí 

VD Moravská Třebová. Území je také zhodnoceno z hlediska ochrany obyvatelstva, 

přičemž z významných objektů se v záplavovém území nachází Základní a mateřská 

škola Linhartice a obchodní dům Lidl Moravská Třebová a z ohrožujících objektů např. 

dvě čerpací stanice, skládka odpadu a rozvodna elektrické energie ve městě Moravská 

Třebová a v obci Linhartice čistírna odpadních vod. Pro záplavovou oblast byl taktéž 

stanoven počet obyvatel potřebných k evakuaci. 
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SUMMARY 

The construction and operation of hydraulic structures is connected with a danger of a 

partial or total damage of the barrier, which can lead to the destruction of the structure 

and thus cause unusual flooding.  Nowadays, it is not possible to eliminate those 

catastrophes; nevertheless, with the help of the current programmes used for modelling 

those extreme hydrological structures, it is possible to determine the magnitude of the 

unusual flood and thus establish the size of the area, which will be affected. 

The goal of this thesis was to make a model of a flood wave after the destruction of a 

chosen reservoir. The first part of the thesis contains the description of extreme 

hydrological occurrences, with the focus on the unusual flood and hydrological models, 

which are further divided and the most famous ones are described. The next part consists 

of the preparation of data in the ArcGIS programme, extension HEC-geoRAS, for 

modelling flood waves after the destruction of a chosen reservoir, which is the Moravská 

Třebová reservoir. The software was changed, in respect to the assignment of this thesis, 

from the precipitation-drainage model HEC-HMS to the hydrodynamic model HEC – 

RAS, which was chosen for being more suitable for this particular kind of modelling and 

for its free availability. In the following part, the process of modelling on this 

hydrodynamic model is described, as well as the methods and parameters used. The thesis 

was created with the help of the national company Povodí Moravy and HZS of the 

Olomouc and Pardubice region. 

The main result of this bachelor thesis is the modelled flood wave caused by the 

destruction of the Moravská Třebová reservoir, with the unusual flood area determined 

and followed by the evaluation of the flooded area with the respect to the protection of 

the inhabitants. This evaluation takes into consideration the town of Moravská Třebová 

and the Linhartice village. Other results are maps showing the flooded area, the different 

uses for the flooded soil, the flooding of important or dangerous objects, roads, streets 

and other information about the protection of the inhabitants. 

The results of the bachelor thesis will be used as a reference for the flood plans of the 

HZS and will be shown on their information servers (map servers). Moreover, the results 

could also serve in the emergency control of the affected towns of Moravská Třebová and 

Linhartice, or they can be used in the region’s emergency plan. The graphic results can be 

used by the national company Povodí Moravy, because they do not have any maps 

created for this unusual flood yet. 

 


